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CHAPTER-1 

INTRODUCTION TO COMPUTER & WINDOWS 
 

1.1 Definition of computer 
 Computer is an electronic device or machine which accept 

data through Input device (Keyboard) and process it in processing unit 

(CPU) and produce desire output or information through output 

devices (monitor or printer) 

 

 

 

 

1.2 Characteristics of Computer 
Accuracy 

Though a computer is a machine it produces 100% correct result. It does never a 

mistake, because it produces desire information according our input data. If we 

programmed properly it will come up with the most accurate answer. That is why the term 

GIGO (Garbage In Garbage Out) is associated with accuracy of computer. 

Speed 

 A computer executes the given instructions in billionth or trillionth of a second. 

The unit of processing time in computers are measure in like: 

  1 Mili second  - 10
-3

 second  

  1 Micro second  - 10
-6

 second  

  1 Nano second  - 10
-9

 second  

  1 Pico second  - 10
-12

 second  

Storage 

 A computer can store large amounts of information. It can also retrieve any part 

of the information instantly, i.e. a single PC can store the whole information of a office. 

Such as in a floppy, you can store 1.44 MB or 500 pages text approximately. In a CD you 

can store 700MB i.e. 700 times more data than a  floppy. In a hard disk you can store 

500GB data which store the entire information of a big office. 

Multitasking 

 A computer can carry out various kinds of tasks ranging from preparation of 

documents to launching of satellites. It is possible through different types of programs or 

software. A computer can do more than one job at a time without reducing it's speed. In a 

single computer you can control more than 40 users at a time. For ex. In LAN there are 2 

to 40 or 50 computers are connected in a single main PC is called Server, which control 

to all system in the same time & allows doing different task in the same time. 

INPUT PROCESS OUTPUT 
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Automation 

 Once the data and instructions are fed into a computer, normally, no human 

intervention is necessary during processing. 

Diligence 

 A computer never gets bored or easily fatigued. It does not ask for a break after 3 

to 4 hours of continuous work. A computer can work 24 hours continuously for years 

except for periodic breaks necessary for its maintenance. 

Application of computer: 

 1. Record Keeping 2. Customer Service 

 3. In Hospital 4. Education 

 5. Animation 6. Space & Defence 

 7. Data processing Activities 8. Traffic Light 

 9. Banking 10. Railway Reservations 

 11. Air Traffic Control 12. Scientific Research 

 

1.3 THE COMPONENTS OF COMPUTER 
 The main components of a computer are: 

o Hardware 

o Software 

o Firmware 

o Personnel or Human ware 

 

1.3.1 Hardware 
Hardware is the various physical components that comprise a computer system, 

as opposed to the non-tangible software elements. Most of these physical components 

are physically separated from the peripheral to the main circuitry that does the 

arithmetical and logical processing but they are the most familiar bits of a computer.  

The physical components of a computer whether it is mechanical or electrical or 

electronics, to which you can touch and see.  

The Hardware parts are: 

 Input Devices 

 Output Devices 

 Processing Units  

 Memory or Storage 

1.3.1.1 Input Devices 
 The Input devices are reading or transmitting the data and store it in the internal 

memory for processing, so they are called as read only devices.  Write the data into 

secondary storage devices, or write the data onto the output devices. The most 

commonly used input devices are Keyboard, Mouse, Scanners, Light pen, joystick etc. 
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KEYBOARD  

The keyboard is an important tool that allows a user to communicate with the 

computer. It is composed of “keys” that send a signal to the computer that the computer 
recognizes and uses to carry out processes and programs. Keyboards come in various 

shapes and sizes, but serve generally the same purpose. We’ll go over the specific keys 
in another part of this guide.  

The Keyboard   resembles a typewriter keyboard, but has additional keys for handling 

control functions. There are different types of key in a key board. Some key board have 

84, 102,104,108,110, and 125 keys. On your keyboard the most widely used keys are 

alphanumeric keys and other characters on the main pad. 

The different keys are: 

Alphabets:  A to Z.,  

Numeric Keys: 0 to 9.,  

Special Symbols: ($- Dollar, &- Ampersand, #- Hash, @- At the rate of, ^- Caret 

(exponeation) 25 = 5^2, ~ - Tile, |-pipe line, \- Back Slash, /- Front Slash,  

Symbol Keys: +, -, *, /, ( ), [ ], { }, . etc. 

Special Keys:  

Enter Key- This is called command key or return key because after pressing enter key 

the computer process the data. To create a new paragraph you can also press enter key. 

Shift key- To change the mode of character from small to capital and vice versa or to 

write the upper case symbol such as ?, +, { }, [ ], $, @, ^ etc., you can hold the shift key 

then press the particular key. 

Caps Lock:  To write all alphabets in capital letter first you on the Cap Lock key then you  

type the alphabets. 

Arrow Key: (left, right, up, down): To move the cursor (blinking position on the screen) 

into four directions you can use different arrow keys. 

Home& End: Home key take the cursor to the first position of the current line where as 

the End key take the cursor to the end position of the current line directly.  

Page up / page down: To move the cursor one 

screen full (15 to 20 lines) upwards or downwards 

you can use the page up/ page down keys. 

Back Space & Delete:  Both keys are used to 

delete or erase the character. The Back Space 

delete the character to back or left side from the 

cursor position where the delete key delete the 

character at the cursor position towards the right. 

Function Keys: (F1 to F12):  There are twelve function keys which function differently 

according to the different application. 

Escape Key (Esc): To cancel any commands you can press the escape key and return 

to previous position. It also helps to quit from any application. 
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Num Lock:  When num lock is on, the number will function in the numeric pad. But when 

it is off the other keys such as home, end, page up, page down will function in the 

numeric pad. 

Print Screen: It prints the current screen matter through printer directly or you can copy 

the current screen matter to the clipboard and paste it in different application. 

 

Mouse  

Similar to the keyboard, the mouse is used to 

communicate with the computer. The mouse is like a remote 

control to a TV. The   Mouse is a small pointing device 

containing a tracking ball  in its base and  fits into  the  palm of 

a  hand. A mouse can be rolled across a flat surface which   

moves the tracking ball on the mouse pad, thus transmitting 

pulses according to its motion. The movement of the tracking 

ball controls the movement of the cursor (pointer) on the 

screen. The Mouse has facilities like pointing to an object, 

selecting an object,  dragging/moving  an  object  and  the like. 

It has two or three buttons: 

 Primary button which is used to selecting a menu or text.  

 Secondary button which is use differently in different 

applications. Basically it allows choosing different menu 

commands.  

JOYSTICK 

 Joystick is an input device by which you can play video 

games. It has a gear/button by which you can control own games.   

LIGHT PEN 

 The Light pen is also a graphic input device by which you 

can  draw graphs directly on the surface of the monitor. The pen 

consists of a photocell placed in a small tube. The light from the 

screen causes the photocell to respond when the pen is pointed 

directly at a lighted area or you can write the pen in a pad. 

SCANNER 

 The scanner is also an input device by which you can scan photo graph and 

store in the computer's memory. It also used to read the Bar Codes  and display the 

detail information about a company. It also sort out the 

competitive exams results. The different scanners are: 

o OCR- Optical Character Reader 

o MICR- Magnetic Ink Character Reader 

o OMICR- Optical Magmatic Ink Character Reader 

o BCR- Bar Code Reader 
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1.3.1.2 OUTPUT DEVICES 
 The output of a computer can be produced the information on the paper using 

either a Printer or a Plotter or produced softcopy on the monitor. 

PRINTER 

 The printers are the most common output devices; they are 

used to get result printed on paper (hard copy). There are different 

types of printer. They are impact printer and non-impact printer.  

IMPACT PRINTER 

 It prints the character by physical striking the print hammer 

on the surface of the ribbon and form a character on the paper. e.g.  

Dot Matrix Printer, Daisy Wheel Printer, Drum Printer & Chain 

Printer.  

NON IMPACT PRINTER 

It prints all the information with the help of Ink Cartridges or toner. It has no print 

head.  It prints all the information through a Photocopier drum like Xerox Machine.  

 e.g.  Laser printer,  Inkjet printer 

PLOTTER 

It is just like a printer by which you can print technical 

diagrams, engineering & geographical  maps where  accuracy is 

of  prime importance. A  pen   is mounted on an arm which can be 

moved up and down or left to right. Figures, characters and 

graphics can be drawn using a plotter.  

MONITOR  

A VDU is the primary output device of a computer. What we type or the results of 

our computations we can see on the Monitor or VDU (Visual 

Display Unit).  What you can see on monitor are called Soft 

Copy. There are two types of monitor :  Mono Chrome (Black & 

White) and color monitor. Monitor are of different sizes, such as 

14", 15", 17", 21" etc. It has different buttons & switches to 

control the brightness, contrast & colour.  

Monochrome monitors has one background and  another 

foreground color. A color monitor can display 16 colours to 512 

or higher number of colours depending on the quality of the 

monitor. The quality of text and graphics of a display can vary 

depending on its resolution factor. Resolution refers to the maximum number of dots 

(pixels or Picture Element) that can be accommodated in both horizontal and vertical 

directions in the display. The currently available SVGA (Super Video Graphics Adaptor) 

monitors have better resolution compared to earlier CGA (Color Graphics Adaptor) 

monitors,  EGA (Enhance Graphics Adaptor) monitors, HGA(Hercules Graphic Adaptor) 

monitor. 
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1.3.1.3 CENTRAL PROCESSING UNIT 
The Central Processing Unit s also called Processor. This is the brain or heart of 

the computer equipment. The CPU carries out the calculations for the 

program and controls the other components of the system. It does the 

function by organising circuits into two main units, called Arithmetic logic unit 

and control unit. It is  the  brain  of  the  computer. It also called Micro 

Processor or Processor Chip). It processes information by fetching an 

instruction stored in  the  memory  ( RAM ),  executing   the  instruction  and 

proceeding to the next instruction. The different processor name are 80186, 

80286, 80386, 80486, 80586 (Pentium -I), Pentium -II,  Celerun, Pentium -

III, Pentium –IV, core I3, core I5, or core I7 etc. 

It contains three parts 

 ALU 

 CU 

 Memory 

ALU 

The ALU contains circuits that do arithmetic and perform logical operations. 

The control unit contains circuits that analysed and execute instructions. 

The ALU contains arithmetic circuits that can subtract multiply and divide 

two numbers. More complex operations such as finding the square root of a 

number are done by sequence of their basic operations. The ALU has logic 

circuits that can compare two numbers to determine if they are equal or if one number is 

greater than storage locations called storage registers for storing numbers used in 

calculations and for storing the results of calculations. To perform a calculation or logical 

operation, number is transferred from primary storage to storage registers in the ALU. 

These numbers are sent to the appropriate arithmetic or logic circuit. The results are sent 

back to the storage registers. The results are transferred from the storage registers to 

primary storage.  
CU (Control Unit) 

 The control Unit controls the whole computer system by performing the 

following functions: 

- directs and coordinates all operation called for by the program 

- activates the appropriate circuits necessary for inputs and output devices. 

- Causes the entire computer system to operate in an automatic manner. 

The control unit contains a temporary storage location called an instruction register for 

storing the instruction being executed. It also contains circuits called the instruction 

decoder – which analyse the instruction register and cause it to be executed.  

Memory 
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It is nothing but a storage location inside the computer. It stores data either permanently 

or temporarily up to switch up the computer. The memory can be broadly classified into  

two types : Primary Memory  & Secondary Memory 

PRIMARY MEMORY 

 It is also called the main memory or internal memory or Immediate Access 

Storage (IAS) of a computer system. It also again sub divided into two types i.e. RAM & 

ROM 

RAM (RANDOM ACCESS MEMORY) 

 Input area – where the data is stored when it is read 

into CPU, awaiting processing. 

 Operating system – controls the operation of the 

computer. 

 Working storage – where calculations are performed 

and data is stored temporarily. 

 Output area where the information is stored prior to 

output. Both the input and output areas are buffer. 

 Application program area – where the user program is held. 

. 

ROM (READ ONLY MEMORY) 

Many computers have another type of primary 

storage called ROM – Read Only Memory. ROM is non-

volatile storage. This means that when the power to the 

computer is turned off, the content of the ROM is not lost. 

ROM can store preset programs that are always put by 

computer manufactures. When you turn on a PC, you will 

usually see a reference on BIOS (Basic Input output 

System). This is part of the ROM chip containing all the programs needed to control the 

keyboard, monitor, disk drive and so on. 

SECONDARY STORAGE 

Secondary Storage is an optional attachment, which is cable –connected to the 

CPU. Secondary is non volatile. Any data or programs stored in secondary storage stays 

there, even with the computer power turned off, unless someone 

purposely erases them. Secondary storage is a permanent from of 

storage. It is also called the External Memory or Secondary 

memory or Auxiliary memory in which you can store data 

permanently for future use. Once you store data in that memory, it 

hold the data up to next deletion. The most widely used secondary 

storage devices are Floppy disks  Winchester (Hard) disks and CD-

ROM. 

HARD DISKS 
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Each computer must have a hard disk i.e. primary Disk. Because it contains the 

entire information of a computer. All the programme, files or folders are store in the 

hardisk. Most PC's have an internal fixed hard disk, but external disks may be used too. 

External disks sit alongside the computer in an extra 'box' with its own power supplies 

and plug socket. An average PC may have 10 to 500 GB.  

FLOPPY DISKS 

 Modern PCs will also have one or two floppy disk drives. The floppy disk 

provides a cost effective means of on-line storage for small business computer systems. 

 Floppy disk are used in the smallest microcomputer system as well as 

with minicomputers and are particularly useful in providing a means of 

decentralized processing. 

 A 'floppy' disk can be 3.5" in diameter or 5.25". A 3.5" disk can hold up 

to 1.44Mb of data. 

CD -ROM /DVD (OPTICAL DISK). 

It is called laser or optical disk.  The capacity of optical disk is very compared 

with other media and they are more difficult to damage. The latest PCs are 

now automatically with a CD-ROM drive and some software packages are 

now only available on CD-ROM. CD-ROM stands for Compact Disc Read-

Only Memory. This means that data is implanted onto the disc when it is 

made, and subsequent users can only retrieve information, they cannot 

alter or overwrite or delete what is already on the disk. A CD-R can hold up 

to 700Mb. And DVD upto 4.7GB to 8.5 GB Once made, CD-ROMs are not 

reusable in the way that floppy disk are. However, a reusable disk (CD-

RW) has recently become available. 

Pen drive 

A USB flash drive, also known under a variety of other names flash memory with 

an integrated USB interface. USB flash drives are typically 

removable and rewritable, and physically much smaller than 

an optical disc. USB flash drives are often used for the same 

purposes for which floppy disks or CDs were once used, i.e., for 

storage, data back-up and transfer of computer files. They are 

smaller, faster, have thousands of times more capacity, and are 

more durable and reliable because they have no moving parts. 

The capacity of  a pen drive is from 1GB to 32GB. 

Blu-ray Disc   

Blu-ray or Blu-ray Disc (BD, BRD) is a digital optical disc data storage format like 

CD or DVD. It was designed to supersede the DVD format, in that it is capable of storing 

high-definition video resolution (1080p). The plastic disc is 120 mm in diameter and 1.2 

mm thick, the same size as DVDs and CDs but more capacitor upto 300GB storage 

capacity.. 

https://en.wikipedia.org/wiki/Flash_memory
https://en.wikipedia.org/wiki/USB
https://en.wikipedia.org/wiki/Optical_disc
https://en.wikipedia.org/wiki/Floppy_disk
https://en.wikipedia.org/wiki/CD-ROM
https://en.wikipedia.org/wiki/Moving_parts
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1.4 TYPES OF COMPUTERS 
According to the shape, size, and working capacity of computer there are mainly 

6 types of computer. 

• Desktop computers 

• Workstations 

• Notebook (or laptop) computers 

• Tablet computers 

• Handheld computers 

• Smart phones 

 

There are four main types of multi-user computers: 

• Network servers 

• Mainframe computers 

• Minicomputers 

• Supercomputers 

DESKTOP COMPUTERS 

The most common type of personal computer is the 

desktop computer—a PC that is designed to sit on (or more 

typically under) a desk or table. Today’s desktop computers are 
powerful and versatile, and they are used for an amazing array of 

tasks. Not only do these machines enable people to do their jobs 

with greater ease and efficiency and also we can listen music, edit 

photographs and videos, play sophisticated games, and much 

more. Used by very one from preschool to nuclear physicists, 

desktop computers are indispensable for earning, work, and play.  

WORKSTATIONS 

A workstation is a specialized, single-user computer that typically 

has more power and features than a standard desktop PC. These 

machines are popular among scientists, engineers, and animators who 

need a system with greater-than-average speed and the power to 

perform sophisticated tasks. Workstations often have large, high-

resolution monitors and accelerated graphics-handling capabilities, 

making them suitable for advanced architectural or engineering design, 

modeling, animation, and video editing.  

NOTEBOOK COMPUTERS 

Notebook computers, as their name implies, approximate 

the shape of a writing notebook and easily fit inside a briefcase. 

Because people frequently set these devices on their lap, they are 

also called laptops. Notebooks have a “clam-shell” design; during 
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use, the notebook’s lid is raised to reveal a thin monitor and a keyboard. When not in 
use, the device folds up for easy storage. Notebooks are fully functional microcomputers 

the people who use them need the power of a Notebook computers help people get their 

work done no matter where they are. The screen, keyboard, and system unit of a desktop 

computer is a familiar sight practically everywhere. full-size desktop computer wherever 

they go. Along with the monitor and keyboard, notebooks also typically contain a mouse, 

DVD player, and wireless networking capability. Notebook computers come in a variety of 

sizes, with different sets of features and hardware to accommodate a wide range of user 

preferences. Notebook computers can operate on either an AC adapter or special 

batteries. They generally weigh less than eight pounds, and some even weigh less than 

three pounds. Some notebook are small, compact computers with reduced processing 

power and often without extra devices such as DVD drives. They are designed both for 

notebook shoppers with a very low budget and for users who only need a computer for 

casual use. Because of their portability, notebook PCs fall into a category of devices 

called mobile computers. 

TABLET PCS 

The tablet PC is the newest development in portable, full-featured computers. 

Tablet PCs off er all the functionality of a notebook PC, but they are lighter and can 

accept input directly from a special pen—called a stylus or a digital pen—or even the 

user’s fingers. Some of the newer models can display an 
image of a keyboard on the screen and allow the user to 

type. Many tablet PCs also have a built-in microphone and 

special soft ware that accepts input from the user’s voice. A 
few models even have a fold-out keyboard, so they can be 

transformed into a standard notebook PC. Tablet PCs run 

specialized versions of standard programs and can be 

connected to a network. The popularity of tablet PCs has 

exploded in recent years both for business and personal use. 

The combination of portable size and friendly interface makes them ideal in a wide range 

of circumstances for note-taking, document sharing, and online communication. 

HANDHELD PCS 

Handheld personal computers (or just handheld PCs) are computing devices 

small enough to fit in your hand. Though they can be indispensable tools for many types 

of A tablet PC. users, their small size and limited processing power puts them in a 

different category from notebook and tablet computers. 

Handheld PCs are typically used for applications that 

help connect mobile users to online resources; provide 

portable entertainment in the form of games, music and 

video; and assist with mobile computing tasks such as 

taking notes and managing address books or task lists. 
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Many users rely heavily on their handheld PC to stay current all day long with the latest 

news from the world and their friends. As handheld PCs  became widely popular in the 

1990s and early 2000s, they were commonly known as personal digital assistants 

(PDAs). Early PDAs had a limited set of soft ware programs that they could run, many of 

which were targeted toward note-taking, small spreadsheets, and appointment 

management. Input to the PDA was commonly accomplished via tapping and drawing on 

a touch sensitive screen with a stylus. Now, handheld PCs often have intuitive and 

shortcut-rich user interfaces with colorful displays, and touch screens that can accept 

various kinds of fingertip taps and swipes for input.  

SMART PHONE 

The term smart phone was coined as manufacturers of cellular telephones began 

including PDA features and programs in their telephones. The 

combination of PDA and cell phone produced a convenient multi-

function device that proved Smart phones provide communication, 

computing power, and more.  

NETWORK SERVER 

A network server is a powerful personal computer with 

special soft ware and equipment that enable it to function as the 

primary computer in the network. Though their exact functions are 

different from organization to organization, network servers all have 

the basic task of making documents, programs, and in some cases 

other computer hardware available to others. For example, a network 

server might run the e-mail services for a company. Rather than having each employee 

run his or her own mail program, employees simply access the central e-mail program 

running on the server to retrieve their messages. Network servers are also responsible 

for sending Web pages to users who are browsing the Internet; a single server can send 

its Web pages to thousands of people visiting the site that it hosts.   

MAINFRAME COMPUTERS 

Mainframe computers are large, powerful 

systems used in organizations such as insurance 

companies and banks, where many people frequently 

need to use the same data. In a traditional mainframe 

environment, each user accesses the mainframe’s 
resources through a device called a terminal. There 

are two kinds of terminals. A dumb terminal does not 

process or store data; it is simply an input/output 

(I/O) device that functions as a window into a computer located somewhere else. An 

intelligent terminal can perform some processing operations, but it usually does not have 

any storage. In some mainframe environments, however, workers can use a standard 

personal computer to access the mainframe.  
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MINICOMPUTERS 

First released in the 1960s, minicomputers got their name because of their small 

size relative to other computers of the day. The capabilities of a minicomputer are 

somewhere between those of mainframes and personal computers. For this reason, 

minicomputers are oft en called midrange computers. Like mainframes, minicomputers 

can handle much more input and output than personal computers. Although some “minis” 
are designed for a single user, the most powerful minicomputers can serve the input and 

output needs of hundreds of users at a time. Users can access a central minicomputer 

through a terminal or a standard PC.  

SUPERCOMPUTERS 

Supercomputers are the most powerful computers and physically they are some 

of the largest. These systems can process huge amounts of data, and the fastest 

supercomputers can perform nearly two quadrillion calculations per second.  

Supercomputers like Cray’s XT5 
Jaguar are massive machines, 

integrating hundreds of thousands of 

smaller processors together. Some 

supercomputers link together 

hundreds of thousands of 

processors. Supercomputers are 

ideal for handling large and highly 

complex problems that require 

extreme calculating power. For 

example, supercomputers are actively used in the mapping of the human genome, 

forecasting weather, and modelling complex processes like nuclear fission. 

1.3.2 SOFTWARE 
Software is the computerised instructions that operate the computer, execute 

particular functions or tasks, and manipulate the data. For software (the instructions) to 

perform various functions, it must be programmed. That is, the instructions need to be 

written in a programming language that the computer can understand. Without a 

program, a computer is useless. In addition to the physical devices, the computer also 

requires a set of instructions that specify how the input is to  be processed called the  

software.   

Programme 

A set of related data written in a sequential manner to do a particular task is 

called a programme. 

Classification of Software 

There are two kinds of software, systems software and applications software. 

SYSTEM SOFTWARE 
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It controls the operations of the hardware and helps in running  the  computer  

system  efficiently  and  conveniently.  Without the presence of System software we 

cann't run any application software. For example - Operating  Systems, Compilers, 

Assemblers etc. are classified as System Software. 

Systems software includes the operating system and all the utilities that enable the 

computer to function. The most important program that runs on a computer is the 

operating system. Every general-purpose computer must have an operating system in 

order to run other programs. This includes controlling functions such as the coordination 

of the hardware and applications software, allocating storage facilities, controlling the 

input and output devices and managing time sharing for linked or networked computers. 

In many respects an operating system works like an air traffic controller to coordinate 

activities within the computer. Examples of operating systems are Windows, DOS and 

OS/2. The Windows family of operating systems includes a Graphical User Interface 

(GUI) that makes the software user friendly. i.e. Operating system 

APPLICATIONS SOFTWARE 

Application Software includes programs that users access to carry out work. 

They include applications for the following functions. 

• Word processing is the most common applications software. The great 

advantage  of word processing over using a typewriter is that you can make changes 

without retyping the entire document. Word processors make it easy to manipulate and 

format documents. For ex. Ms Word, Page Maker, Wordpad Etc. 

• Spreadsheets are computer programs that let people electronically create and 

manipulate spreadsheets (tables of values arranged in rows and columns with predefined 

relationships to each other). Spreadsheets are used for mathematical calculations such 

as accounts, budgets, statistics and so on. For ex. Ms excel, VP planner etc. 

• Database management applications are computer programs that let people 

create and manipulate data in a database. A database is a collection of related 

information that can be manipulated and used to sort information, conduct statistical 

analyses or generate reports. For ex. Dbase, foxpro, access, oracle or SQL server etc. 

• Presentation packages and graphics are computer programs that enable users to 

create highly stylised images for slide presentations and reports. They can also be used 

to produce various types of charts and graphs. Many software applications include 

graphics components including: paint programs, desktop publishing applications and so 

on. For ex Power Point etc. 

   

1.5 WINDOWS 7 
 

The operating system on the 

computer is the program that starts when 



17 

you turn on the computer. It performs the basic tasks required to use the computer, 

including interacting with the computer hardware, scheduling tasks, and maintaining files. 

The operating system also manages the other programs on the computer. If you are 

using a PC, you will probably have one of the following operating systems: Windows 98, 

Windows Me, Windows NT, Windows XP, Vista,  Windows 7, windows 8 and windows 10 

etc. Computers using a Microsoft Windows operating system have the following features:  

Among all windows base operating system the Windows 7 Enterprise and Windows 7 

Ultimate are the most versatile and powerful editions and are designed to address the 

needs of both enterprise customers and consumers who want every feature of 

Windows7. 

Windows 7 Ultimate is intended for large, global organizations and includes all 

the features in the Professional version. To increase compatibility, it can work with 

Windows XP to run any program Microsoft has to offer without the use of multiple 

operating systems. Like Vista Enterprise, Windows 7 comes with multiple language 

interfaces for access to any of the 35 languages; this allows users to switch between 

languages without additional add–ons. 

Multimedia 

Home Group is a new multimedia feature in Windows 7. With this simple tool, 

you will be able to connect with anyone on your network, share images, movies, music 

and any other media you desire. With new formats for playing movies and music such as 

H.264 video and AAC audio files, Windows Media Player 12 is now ready for most 

anything you can throw at it. With the new Jump List you can access your favourite 

multimedia files without ever even opening the program. Another fun Home Group add-

on is the ability to have a TV tuner card installed in your system. Never miss your 

favourite shows again. 

Security 

Microsoft addressed the over extensive use of UAC (User Account Control) 

everyone ran into when trying to do pretty much anything on Vista. Everyone remembers 

the annoying pop up window every time you wanted to download something, install a new 

program or any other task. Microsoft had the correct idea for keeping your system safe 

and secure; they came about it in the wrong way. With Windows 7, you can manage how 

often these annoying popup windows appear or if they appear at all with the configuration 

slid bar that allows you to choose from among four levels of UAC protection. You will also 

be able to manage user accounts with much greater detail for children and others that 

may use the same computer. 

Networking 

Windows 7 has made networking easy for everyone, not just the computer savvy 

users out there. Locating and accessing networks is no longer a huge process. With 

Windows 7‘s new ability to locate networks you will find them quick and be able to 
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connect with no problems; however, if you do encounter a problem, follow the step-by-

step wizard for locating and establishing a network.  

Libraries are another new feature that allows the user to add the word Personal before 

each folder to distinguish between public and personal documents. You can then take 

these personal and public documents and add them into a single directory for a much 

cleaner looking and more manageable network. 

Home Group is another feature that makes networking simple and fun. You can 

install and use printers with a few clicks and share any media file through a home 

network. We didn’t like that everyone using Home Group has to be running Windows 7 or 
they can’t access your information. 

If you work for a company that allows you to work from home by remote access, 

you shouldn’t have any problems accessing Windows 7. You can remote in no matter 
what OS you are running; we tested the remote access running a XP and Vista version of 

Windows with no problem. You will not be able to use some of the ease of use features 

such as the Aero Shake and other Windows 7 only features. However, the overall 

performance when you remote in is very smooth, most programs have no problem 

running and there is very little delay. 

Ease of Use 

Windows 7 was made to be a user-friendly, easy to use operating system that 

anyone can figure out and use without any previous computer skills. One of the standout 

features that makes Windows 7 so easy to use would be the Snapping tool, a tool that 

allows you to drag any window to one side of the screen or the other to make it half the 

size of the screen. Those of you who like to do comparisons, write articles or do anything 

that requires multiple programs to be open at once, the snapping tool will be a life saver.  

Another feature that makes Windows 7 so user-friendly is the ability to pin any program to 

your start menu or to the taskbar, this allows for quick access to your most used 

programs. Along with the ability to pin your favorite programs, we loved the Jump List 

feature, this feature allows you to right click any program on your taskbar and Jump Lists 

will take you right to the documents, pictures, songs, or websites you have used most 

recently or ones you use most often. 

One thing that Microsoft brought back from Vista that simplifies the search process is the 

Windows Search feature. Find any file on your system, from music to a paper you 

finished writing for school, searching for it the same way you would search for anything 

on the web and Windows 7 will do the rest. 

Technical Help/Support 

Everyone has looked over Windows 7 with a fine tooth comb. No one wants to 

get the latest and greatest OS and find out it is a disappointment. From the first day of 

beta testing until its final release date questions and concerns have been pouring into 

Microsoft’s office. There is a response to any question you may have and if there isn’t, 
well there are plenty of ways to get a hold of someone and find the answers you seek. 
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Along with phone numbers, email, online help, internal help and wizards you should have 

no problem getting the answers you seek. 

Direct Access for Mobile Workers 

It Allows IT administrators to update Group Policy settings and distribute software 

updates any time the mobile device has Internet connectivity, whether or not the user is 

logged on. DA supports multi-factor authentication and encryption. 

XP mode - Allows older applications designed for Windows XP to use a virtualized 

version of the XP operating system. To the end user, the applications seem to be running 

right on the Windows 7 desktop. 

Virtual hard disk support - Allows you to mount a virtual hard disk (VHD) and interact 

with it as if it were a physical drive. 

Enterprise Search - Extends search to remote document repositories, SharePoint sites 

and Web applications. 

AppLocker - Allows IT administrators to use Group Policy to specify rules about what 

software applications can be run on a particular user's desktop. 

Enhanced VDI - Allows administrators to use the same master image for both remote 

clients using virtual desktop infrastructure and traditional desktop computers. 

According to Microsoft, Windows 7 requires 1 GHz processor (32- or 64-bit), 1 GB of 

RAM (32-bit) / 2 GB of RAM (64-bit), 16 GB of available disk space (32-bit) / 20 GB of 

available disk space (64-bit) and a DirectX 9 graphics device with WDDM 1.0 or higher 

driver 

 

The desktop: When you first log on to the computer, you see the desktop. The desktop 

is the display area you see when Windows opens. The major parts of the Windows 

desktop include the following:  

Start button: The Start button 

is in the lower left-hand corner 

of your screen. In Window 7, 

the round Microsoft globe is the 

Start button. (In earlier version, 

the button was labeled “Start”) 
This button opens the Start 

menu, which is what you can 

use to open programs and 

documents.  

Taskbar: The long horizontal 

bar at the bottom of the 

desktop  is the taskbar.  The 

taskbar contains three elements; the Start menu button; buttons for open windows, which 

does not show and the time of day indicator at the right end of the taskbar.  and also 
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shows a power indicator, which you see only if you are running Windows  on a laptop 

with power management features.  

 

System Tray: The right-hand part of the taskbar that holds the clock, volume control, and 

icons for other utilities that run in the background of your system.  

Shortcut icons: These are links to programs, file or folders that you can place on your 

desktop.  

Recycle Bin: This is where you can drag and drop any files you want to delete.  

Mouse pointer: The indicator on the screen that you use to select and move objects. It 

moves as you move the mouse and it changes appearance depending on what program 

you are using and what tool you have selected.  

 Windows: Using the Microsoft Windows operating system, you can have more than one 

program or folder open for viewing at the same time. Each program or folder is in its own 

window, a rectangular area on the screen. Having multiple windows open is similar to 

having multiple books open on the top of a desk.  

Each window contains different information. For instance, you can have a window open 

that displays a letter you are writing and a window that displays a map of the world. When 

you are using multiple windows, the one you are working in is called the active window. 

The active window is located on top of the other windows and is in the foreground.  

Common Windows elements: 

 Most windows have common features, so once you become familiar with one program, 

you can use that knowledge in another 

program.  

Toolbars: The bar below the menu 

bar containing buttons that provide 

access to the most commonly used 

tools in a program. Each button has a 

picture on it, also called an “icon”, 
which represents the buttons action.  

Ribbons: If you are using a Microsoft 

Office 2010 product, you do not have 

menus or toolbars. Instead you have 

the “Ribbon”. Ribbons are accessed by 
clicking on any of the tabs towards the 

top of the window. Depending on what 

tab you click, you can access different 

Ribbons. Each ribbon contains a 

different group of icons which performs 

various tasks. For example, on the 

Home Ribbon, you can find icons that 
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will change which font you are using or what size font you are using.  

Minimize button: The left button in the upper-right corner of a window used to minimize 

a program window. A minimized program remains open but it is visible only as a button 

on the taskbar.  

Resize button: The middle button in the upper-right corner of a window used to resize a 

program window. If a program window is full-screen size, that is, it fills the entire screen, 

the Restore Down button is displayed. You can use the Restore Down button to reduce 

the size of a program window. If a program window is less than full-screen size, the 

Maximize button is displayed. You can use the Maximize button to enlarge a program 

window to full-screen size.  

Close button: The right button in the upper-right corner of a window used to close a 

program or document window.  

Scroll bars: A vertical bar on the side of a window and a horizontal bar at the bottom of 

the window used to move around in a document. You can use the scroll arrows to see 

other parts of the screen by “scrolling” up and down or left and right. If the entire 
document is displayed in the window, there will not be a scroll bar.  

Toggling Between Programs  

It can be helpful to have two or more programs open at the same time. For 

instance, you could be researching a topic using the Internet and want to take notes in 

Word at the same time. After you have launched the two programs, its easy to switch 

between one program and the other. To switch to another program (and send all other 

open programs to the background), you can do one of the following:  

Click the applications button on the bottom of the screen in the taskbar.  

Click any visible part of the applications window – including its title bar.  

Hold down the Alt key and then press the Tab key repeatedly until the application window 

you want is selected. This cycles through all open windows. When you‟re at the window 
you want, release the Alt key.  

Icon 

An Icon is a Graphical picture or symbol. Windows  uses small video icons that 

represent objects-documents ,applications, folders, devices, and other computers. An 

icon has a text label that further describes  the object. The four small pictures with labels 

in the upper-left corner. 

Selecting 

Selecting an object is pointing to it without taking any further action .You select 

an object in one of several ways. First, if the object is not a menu selection, you click the 

object to select it ,which means that you move the mouse cursor onto the icon and then 

press the left mouse button once .If the currently selected object is an a group Icon, you 

can change the selected object with the arrow keys. you can change groups with the Tab 

and shift + Tab keys and then use the arrow keys to selected an object is ready to be 

choose. 
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Choosing  

Choosing an object is activating the command associated with the object. which 

means that you move the mouse cursor onto the icon and then press the left mouse 

rapidly two times . If the object is a menu selection or command button ,however, you 

choose the object with a single click . You can also choose the object by selecting it first  

and then pressing the Enter key. 

Drag and Drop 

To drag and drop an object onto another object ,move the mouse cursor onto the 

icon of the object to be dragged .Press down the left mouse button and hold it down while 

you move the mouse cursor to the destination object's icon . 

Release the mouse button from that position to complete the 

drop. 

The Right Mouse Button 

If you move the mouse to almost anywhere or anything 

on the desktop or in a window and click the right mouse button 

,Windows  displays a menu with common commands for the 

object . Many Windows applications use this same convention. 

Try it now . Move the mouse cursor to the clear area on the 

desktop and press the right mouse button . To close the menu 

,click the left mouse button anywhere else on the desktop or 

press the keyboard's Esc key. 

FRAME 

The frame surround the window. When you point the 

mouse to one of the frame edges or corners, the mouse cursor 

changes to an arrow cursor with points at both ends, indicating that the window can be 

resized. Dragging that cursor changes the size of the window.  

Control Menu  

Each window has a control menu which contains commands for manipulating  

the window. You open a window's  control menu by clicking  the icon in the upper-left 

corner of the window, by 

right-clicking the title bar or by pressing Alt+Spacebar for program windows and 

Alt+Hyphen 

for document windows. 

Menu Bar 

Most application windows have a menu bar, which contains the titles of pulldown 

menus. These titles vary from application to application , but standards exit. For example, 

most applications have file, edit, and Help menus. Chapter 6 discusses the use of menu. 

Work Space 
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The work space is that portion of a window that is inside the frame and under the 

title bar and menu bar. This space is also called the client area. The window displays the 

documents in the work space. 

Minimize and Maximize Buttons 

A window can be in one of three configuration with respect to its size and 

placement. It can be restored , which means that it occupies a section of the desktop or 

its parent windows work space. The window can be maximized, which means that it fills 

the desktop or parent window's work space completely. The window can be minimized, 

which means that it is represented by a short title bar at the bottom of  the parent 

window's work space or as a button on the Taskbar.   You can change the window's 

configuration by clicking the Minimize and Maximize buttons in the upper-right corner of 

the window.  

Restore Button 

When a window is Maximized, its Maximize button is replaced by a Restore 

button. When is Minimized button is replaced  by a Restore button. 

Close Button 

Clicking the Close button closes the window. This button is an alternative to 

using the Close command on the control menu. The X icon is  used to close the windows. 

Everything about the close button makes you want to use it to maximize a window until 

you get accustomed to the new usage. It is particularly confusing to people who routinely 

switch  between windows  is released, but Microsoft remains steadfast in its position that 

the close button is OK the way it is implemented. 

Help Button 

Some windows have  a Help button in the button group in the window's upper 

right corner. A help button has a question mark icon. When you click the Help button, the 

mouse button changes to a point with  a question mark. Then when you click an item in 

the window, the system display helpful information about that item.  

Scroll Bars 

Often, the display of data in the windows work space extends beyond the area 

covered by the window . A word processing document is usually much longer than the 

space displayed by the window. To View the hidden data, you must be able to bars allow 

you to do this using the mouse. 

Shutting Down Windows and Your Computer  

The best way to turn off your computer is to tell the computer to shut down. Do 

not turn off your computer by pressing the button on the computer case. You could lose 

data and settings that are temporarily stored in your systems memory To shut down 

Windows and turn off your computer, follow these steps:  

• Save and close any files you have open.  

• Click the Start button (Microsoft globe) in the lower left-hand corner of your 

screen to display the Start menu.  



24 

• Click the Shut Down button.  

Icon on the Desktop 

The upper-left comer of the window contains four icons. These icons provide 

access to your files and documents, other computers on the network, the Recycle bin into 

which you remove items from the desktop, and a briefcase icon to synchronize the files 

on your desktop with those on a laptop computer. 

My Computer 

The  My Computer icon on the desktop opens a view into the resources of the 

local computer. When you choose (double-click) the icon. The contents of the My 

Computer window depend on the disk drives on your PC and the network support that is 

installed. There are icons to open the Control Panel, access the printer, and connect to 

other computers though dial up connections. To examine the contents of a drive, double-

click its icon in the My Computer window. This technique is one of several ways that you 

can view the contents of a drive in Windows XP or 7.  

The contents of the disk drive are represented by object icons. Folder icons are sub 

directories in the file system. Other icons represent documents, data files, applications, 

and so on. You can open a folder by double-clicking its icon. If you choose an application, 

It executes immediately. If you choose an object that is not a folder, a recognized 

document, or an application, Windows asks you which application should be used to 

process the object. 

Recycle Bin 

The third icon on the desktop is the Recycle Bin 

object. This object receives all deleted objects. You can 

delete folders, files, documents, applications, and so on. 

Instead of deleting those objects from the file system, 

Windows puts them the Recycle Bin. 

You delete an object either by selecting it and pressing 

the Del. key on the keyboard or by dragging and dropping 

the object into the Recycle Bin. These objects continue to 

exist in the Recycle Bin. You can get a deleted object 

back by dragging it out of the Recycle Bin and dropping it 

onto the desktop or into a folder.  

Closing Windows 

If you have been following along with your PC, you still have several windows displayed 

on the desktop. To close them and make them disappear, click the small box with the X 

in the upper-right corner of the window. To close the windows from the keyboard, press 

Alt+F4 for each window that you want to close. 

Add Folders in the Desktop : 
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Folders on the desktop can 

contain other folders, documents, 

applications, and shortcuts to 

devices such as printers. To add a 

folder to the desktop, move the 

mouse cursor to an empty spot on 

the desktop and press the right 

mouse button.  Click the New 

command. Then Click the Folder 

command, after that A folder icon 

labeled New Folder appears on the 

desktop. Its label is selected. Type 

the label you want for the folder and 

press Enter. Drag the folder to a 

convenient place on the desktop.  

Documents 

Documents are the data files that you work 

with.  Word processing documents, spreadsheets, 

database files, graphics, and so on are documents.  

To add a new document to the desktop, open the 

menus ,the same way you opened them to add a 

folder to the desktop.  The list of document types 

below the separator line reflects the associations of 

document types to applications.  

Printers  

You can put a shortcut to a printer object 

on the desktop.  Printers are installed in the 

Printers folder under My Computer on the desktop. The Printers folder  contains two 

objects.  The Add Printer object opens a wizard 

application with which you add printers to your 

configuration.  The second icon in Figure 3.9 

represents an HP LaserJet printer connected to my 

PC.  Your Printers folder would contain one or more 

icons labelled to represent the printers on your PC-

assuming you have a printer. You can print a 

document by dragging and dropping it onto a printer 

icon.  Sometimes it is more convenient . 

Applications 

You can put a shortcut to an applications are 

document-oriented, and you access them mostly 
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through documents that you maintain in folders and on the desktop.  Some applications 

are not launched by documents, however.  An example is a communications program 

that you use to call on-line services and bulletin boards.  If you use such an application 

frequently, you might want to put a shortcut to it on the desktop.  I'll show you how to do 

that  soon.   

 Before you can add an application shortcut to the desktop, you have to find the 

application, and you haven't learned how to do that yet.  We'll finish the discussion of 

objects on the desktop and then learn how to use the Find operation through the Start 

menu.  After that, we'll find an application to add to the desktop. 

Renaming Icons 

When you created the folder and document earlier in this chapter, you renamed 

them as soon as you created them.  You were able to do that by typing the new name as 

soon as you created the objects because their icon labels were already selected. 

To rename an existing icon, you must select its label.  Select the object by clicking it.  

Now click on the label.  Allow enough time between those clicks so that they do not get 

processed as a double click.  The label's text is selected, and the keyboard cursor moves 

into the label area.  Type the new label. 

Start Menu 

The Start bottom opens the Start menu.  Click the Start button.  The Start menu 

pops up and display all the menu are in the start menu. It contains three kinds of 

selections,  commands, cascaded menus, and dialog box 

selections.   

Window Buttons 

The middle section of the taskbar is for buttons that 

represent open windows on the desktop. When you open the My 

Computer window, the printers window, and so on, You might have 

noticed that buttons were added to the taskbar. One of these 

buttons seems to be pushed in. The others are popped out. The 

pushed button represents the window that has the focus. If you click on the desktop or 

the Start or time buttons, all the window buttons are popped 

out because no window will have the focus. If you click on a 

popped-out button, its window gets the focus.  

Date & Time 

The time button at the extreme right end of the 

taskbar lets you constantly view the time of day. You can 

view the date by clicking the button. You can set the date 

and time by double-clicking the button. You can set the 

date and time by double-clicking the button, which opens 

the Date/Time Properties dialog box . You used the 

Date/Time Properties dialog box during installation to set 
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the time. The tabs in the upper left corner of the dialog box sets the date and time. Try it 

now. Click on the Time Zone tab. Chose the Cancel command when you are finished 

viewing the dialog box. 

Moving the Taskbar 

When a lot of windows are open, the taskbar isn't long enough to hold all the 

window buttons, You can move the taskbar to a vertical position by dragging and 

dropping it. Click on an empty spot on the taskbar, drag to the right edge of the desktop, 

and drop the taskbar. You can move the taskbar to the top and left side of the desktop in 

a similar manner. 

Finding Things/ search file & folders 

Now we will use the Start menu to choose a 

command that lets us find something. Recall that we delayed 

the discussion about putting an application on the desktop 

until we could find an application. For this exercise, we'll put 

the Calendar application on the desktop. Click the Start 

button to open the start menu. Choose the find command.  

Choose the files or folders command from the cascaded 

menu.  

We are looking for the Calendar application. I happen 

to know that its application file is named calendar.exe. That's 

a good guess anyway, so type application file is named 

calendar.exe. So type calendar in the text box next to the 

Named label. Choose the Find Now command. After some 

searching of your hard disk. 

The original reason for looking for the Calendar was to put it on the desktop. you 

do that dragging and dropping the first Calender entry (from the list in the Find dialog box 

) to the desktop . The desktop with the Calender application addressed. 

Now you can run the Calendar application at any time by clicking its icon. 

Explorer 

The Explorer is a much-improved of the Files Manager application in previous 

versions of Windows. The Explorer provides a  view of the resources of your computer. 

You can run Explorer form any of several places. One way is by right-clicking the My 

Computer icon and choosing the Explorer command 

from the menu. The explorer application starts, 

The left pane of the Explorer window shows the of 

folders that constitutes your computers organization. 

The right pane shows the contents of the currently 

selected folder. Because you launched Explorer from 

the My Computer icon, the right pane shows the 

contents of the My Computer folder. You can select 
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different objects in the pane and change the display in the right pane accordingly. The 

small boxes with plus9(+) characters next to the icons in the left pane indicate the there 

are other objects subordinate to the marked object, but the subordinate objects are not 

displayed. You can click the plus the plus(+) mark to expand the tree to display the 

subordinate objects. The plus mark changes to a minus mark when the tree is expanded 

at that point. You can launch applications from the Explorer by double-clicking icons for 

the applications of double-clicking icons for documents associated with the applications. 

Double-clicking a folder is the same as clicking its plus or minus mark. 

Note pad 

The Notepad accessory program 

window, with the standard window comments 

labelled. Notepad is a text editor that you can 

use for text documents that need no special 

formatting such as fonts and variable typeface 

sizes. You'll  use the Notepad window here and 

the Calculator accessory window later to learn 

the format and behaviour of window in general. 

 To open the Notepad accessories program click 

the start button , choose the programs  

command from  the start menu, choose notepad 

from the second cascade menu .now you can 

use your PC to follow along with exercise in this chapter. 

Paint 

Paint is a graphical composition 

program. You use it to create color 

pictures in Windows 's .Bmp bitmapped 

graphics format. You can incorporate 

these pictures into documents and 

presentations by importing the BMP files 

into a word processor or slide show 

program. 
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Paint is launched from the Accessories menu or by double-clicking a graphical file on the 

desktop or in a folder. You can create a graphical file using the New command of the 

desktop's right -click menu. Choose Bitmap Image from the cascaded New menu. You 

create and modify pictures  using the tools in the toolbox to create effects that use the 

colors in the color box. The tool box is initially on the left side of 

the application window, and the color box is at  the bottom. Both 

are floatable and dockable, which means that you can drag and 

drop them anywhere on the desktop. This feature releases more 

of the application window for the work space, permitting you to 

view more of the picture that you are working on. 

CALCULATOR  

Through the Calculator Application we can calculate 

each and every calculation like a calculator. 

1.6 INTRODUCTION TO WINDOWS 8 
Starting windows 8 

Windows desktop no longer contains the traditional Start button and Start menu 

that sprouted from the corner, you now must retreat to the new Start screen. To open a 

program, click or tap a program’s tile from the 
Start screen, and Windows shuffles you back to 

the desktop, where the newly opened program 

awaits Starting Windows 8 is as easy as turning 

on your computer — Windows 8 leaps onto the 

screen automatically with a flourish. But before 

you can begin working, Windows 8 stops you 

cold: It displays a locked screen, If you’re using a 
touch screen computer, substitute the word tap 

when you read the word click. Tapping twice 

works like double-clicking. And when you see the 

term right-click, touch and hold your finger on the 

glass; lift your finger when the right-click menu 

appears. Starting Windows 8 is as easy as 

turning on your computer — Windows 8 leaps 

onto the screen automatically with a flourish. But 

before you can begin working, Windows 8 stops 

you cold: It displays a locked screen. How you 

unlock the lock screen depends on whether 

you’re using a mouse, keyboard, or touch 
screen: 

✓ Mouse: On a desktop PC or laptop, click any mouse button. 

✓ Keyboard: Press any key, and the lock screen slides away. Easy! 
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✓ Touch: Touch the screen with your finger and then slide your finger up the glass. A 

quick flick of the finger will do. 

 The new Start screen in Windows 8 whisks you away from 

the traditional Windows desktop and drops you into a foreign 

land with no helpful translator  at your side. That’s right: 
Windows 8 no longer has a Start button or a Start menu. The 

Charms bar can be summoned from anywhere within 

Windows 8, whether you’re on the Start screen, the Windows 
desktop, and even from within apps and desktop programs. 

The Charms bar can be summoned from anywhere within 

Windows 8, whether you’re on the Start screen, the Windows 
desktop, and even from within apps and desktop programs. 

But no matter what part of Windows 8 you’re working with, 
you can summon the Charms bar using a mouse, keyboard, or touch screen by following 

these steps: 

When the Charms bar appears, lingering along your screen’s right edge, it sports five 
icons, ready to be either clicked or touched. Here’s what each icon does: 
✓ Search: Choose this, and Windows assumes you want to search through what you’re 
currently seeing onscreen. To expand your search, choose one of the other search 

locations: Apps, Settings, or Files. 

 

✓ Share: This fetches options for sharing what’s currently on your screen. When viewing 

a web page, for example, a click of the Share button lets you choose Mail to e-mail the 

page’s linkto a friend. (I cover e-mail in Chapter 5.) 

 

✓ Start: This simply takes you back to the Start screen. The key on your keyboard or 

tablet also whisks you back there. 

✓ Devices: Choose this to send your current screen’s information to another device, such 
as a printer, second monitor, or perhaps a phone. (The Devices option lists only devices 

that are currently connected with your computer and able to receive the screen’s 
information.) 

✓ Settings: This lets you quickly tweak your computer’s six major settings: Wi-Fi/ 

Network, Volume, Screen, Notifications, Power, and Keyboard/Language. Not enough? 

Then choose the words Change PC Settings along the bottom to open the Start screen’s 
mini-Control Panel. 

 

Introducing your free apps in windows 8 

The Windows 8 Start screen comes stocked with sev- eral free apps, each living 

on its own square or rect- angular tile. Every tile is labeled, so you know what’s what. The 
tiles for some apps, known as live tiles, change constantly. The Finance app tile, for 
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example, constantly updates with the stock market’s latest swings; the Weather tile 
always tells you what to expect when you walk outdoors. 

The Windows 8 Start screen shows only some of your apps; to see them all, right-click a 

blank por- tion of the Start screen and choose All Apps from the screen’s bottom. 
You may spot some or all of the following apps on the list, ready to be launched at the 

click of a mouse or touch of a finger: 

✓ Calendar: This lets you add your appointments or grab them automatically from 

calendars already created through accounts with Google or Hotmail. 

✓ Camera: This lets you snap photos with your computer’s built-in camera or webcam. 

✓ Finance: A live tile, this shows a 30-minute delay of the Dow, NASDAQ, and S&P. 

Choose Finance to see 

the usual charts and 

graphs of fear and 

uncertainty. 

✓ Games: Designed 

mostly for Xbox 360 

owners, this app lets 

you see your friends 

and gaming 

achievements. You can 

explore new games, 

watch game trailers, 

and buy new games for 

your console. 

✓ Internet Explorer: 

This mini-version of Internet Explorer browses the web full screen, with noth- ing to get in 

the way: no menus, no tabs, just 

you and the current page. (When you’re through, press the key on your keyboard to 

return to the Start screen.) 

✓ Mail: Covered in Chapter 5, this lets you send and receive e-mail. If you enter a 

Hotmail, Outlook, or Google account, the Mail app sets itself up automatically, stocking 

your People list, as well. 

✓ Maps: Handy for trip planning, the Maps app brings up a version of Microsoft Bing 

Maps. 

✓ Messaging: Covered in Chapter 5, this app lets you send text messages to friends 

through Facebook, Microsoft’s Instant Messenger, and other systems. 
✓ Music: This plays music stored on your PC. But Microsoft hopes you’ll buy music from 
its store, as well. 

✓ News: Visit here to read the news of the day, compiled from news services. 
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✓ People: The beauty of the People app, covered in Chapter 5, comes from its 

openness. Once you enter your accounts — Facebook, Twitter, 

✓ Photos: Covered in Chapter 6, the Photos app displays photos stored in your 

computer, as well as on accounts you may have on Facebook, Flickr, or SkyDrive. 

✓ Reader: This handy app reads documents stored in the Adobe Portable Document 

Format (PDF). It jumps into action when you try to open any file stored in that document. 

(Most manuals available on websites come in PDF format; you can also find them 

attached to some e-mails.) 

✓ SkyDrive: This term describes the Microsoft Internet cubbyhole where you can store 

your files. By storing them online in SkyDrive, cov- ered in Chapter 3, you can access 

them from any Internet-connected computer. 

✓ Sports: You can find sports news and scores here, as well as a way to add listings for 

your favorite sports teams. 

✓ Store: The Windows Store is the only way to add more apps on your Start screen. 

(Programs you install through your Windows desktop also add shortcuts to the Start 

screen.) 

✓ Travel: Resembling a travel agent’s billboard, this app lists travel hotspots, complete 
with maps, panoramic photos, reviews, and links for booking flights and hotels. 

✓ Video: This works more like a video rental store, with a small button that lets you watch 

videos stored on your computer. 

✓ Weather: This weather station forecasts a week’s worth of weather in your area,  
Exiting from Windows 

Here’s the quickest way to turn off your PC: 
1.  Move your mouse pointer to the bottom-right corner to fetch the Charms bar. (On a 

touch- screen, swipe inward from the right edge.) 

2.  Click the Settings icon and then click the Power icon. 

3.  Choose Shut Down. 

If the computer protests, saying you’ll lose unsaved work, choose Sleep instead. 
Jazzing up the desktop’s background 

To jazz up your desktop, Windows 8 covers it with a pretty picture known as a 

background. (Many people refer to the background simply as wallpaper.) When you tire 

of the built-in scenery, feel free to 

replace it with a picture stored on your 

computer: 

 

1.  Right-click a blank part of the 

desktop, choose Personalize, and click 

the Desktop Background option in the 

window’s bottom-left corner. 
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2.  Click any one of the pictures, shown in Figure 2-3, and Windows 8 quickly places it 

onto your desk- top’s background. 
Found a keeper? Click the Save Changes button to keep it on your desktop. Or, if you’re 
still searching, move to the next step. 

3.  Click the Browse button to see photos inside your Pictures library or My Pictures 

folder. Most people store their digital photos in theirPictures library  or My Pictures folder. 

Try different backgrounds by clicking them; click the Browse button to see pictures from 

different folders. 

4.  Click different pictures to see how they look as your desktop’s background. 
When you find a background you like, you’re done. Exit the program with a click in its 
upper- right corner, and your chosen photo drapes across your desktop 
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CHAPTER-2 

INTRODUCTION TO MICROSOFT WORD 

2.1 Introduction to Microsoft word 

When you use a computer program to create, edit, and format text documents, 

you are performing a task known as Word Processing. Part of the Microsoft Office 2013 

suite of programs, Microsoft Word 2013 is one of the most sophisticated word-

processing programs available. By using Word, it is easy to efficiently create a wide 

range of business and personal documents, from the simplest letter to the most complex 

report. Word includes many desktop publishing features that you can use to enhance the 

appearance of documents so that they are visually appealing and easy to read. 

 

You can use Word to: 

 Create professional-looking documents that incorporate impressive 

graphics. 

 Give documents a consistent look by applying styles and themes that 

control the font, size, color, and effects of text and the page background. 

 Store and reuse pre-formatted elements such as cover pages and 

sidebars. 

 Create personalized mailings to multiple recipients without repetitive 

typing. 

 Make information in long documents accessible by compiling tables of 

contents, indexes, and bibliographies. 

 Coauthor documents with team members. 

 Safeguard documents by controlling who can make changes and the 

types of changes that can be made, as well as by removing personal and 

confidential information. 
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2.2 View of Microsoft word window 

 

Figure 1- Identifying program window elements 

 

The program window contains the following elements: 
 
 Title bar:-At the top of the program window, this bar displays the name 

of the active document and provides tools for managing the program and the program 
window. 

 

 
Figure 2- The title bar of a program window for an existing document. 

 
At the left end of the title bar is the program icon, which you click to display 

commands to restore, move, size, minimize, maximize, and close the program window. 

To the right of the program icon is the Quick Access Toolbar, which by default 
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displays the Save, Undo, and Redo buttons. You can customize the Quick Access 
Toolbar to display any commands you want. 

 
At the right end of the title bar are five buttons: the Microsoft Word Help button 

that opens the Word Help window; the Ribbon Display Options button that allows you to 
entirely hide the ribbon, display only the ribbon tabs, or display the ribbon tabs and 
commands; and the familiar Minimize, Maximize/Restore Down, and Close buttons. 

 

 Ribbon Below the title bar:-all the commands for working with a Word 

documentare gathered together in this central location so that you can work efficiently 

with theprogram. 
 

 
Figure 3-The ribbon, showing the Home tab. 

Across the top of the ribbon is a set of tabs. Clicking a tab displays an 
Associatedset of commands. 

Commands related to managing Word and Word documents (rather than 
document content) are gathered together in the Back stage view, which you display by 
clicking the colored File tab located at the left end of the ribbon. Commands available in 
the Back stage view are organized on pages, which you display by clicking the page tabs 
in the colored left pane. You redisplay the document and the ribbon by clicking the Back 
arrow located above the page tabs. 

Commands related to working with document content are represented as buttons 
on the remaining tabs of the ribbon. The Home tab, which is active by default, contains 
the commands most Word users will use most often. When a graphic element such as a 
picture, table, or chart is selected in a document, one or more tool tabs might appear at 
the right end of the ribbon to make commands related to that specific object easily 
accessible. Tool tabs are available only when the relevant object is selected. 

 
On each tab, buttons representing commands are organized into named groups. 

You can point to any button to display a ScreenTip with the command name, a 
description of its function, and its keyboard shortcut (if it has one). 
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Figure 4- The Backstage view, where you can manage files and customize the program. 

 

When a gallery contains more thumbnails than can be shown in the available 
ribbon space, you can display more content by clicking the scroll arrow or more button 
located on the right edge of the gallery. 

Related but less common commands are not represented as buttons in a group. 
Instead, they’re available in a dialog box or pane, which you display by clicking the dialog 
box launcher located in the lower-right corner of the group. 

To the right of the groups on the ribbon is the Collapse the Ribbon button, which 
is shaped like a chevron. Clicking this button hides the groups of buttons but leaves the 
tab titles visible. When the groups are hidden, the Collapse the Ribbon button changes to 
the Pin The Ribbon button, which is shaped like a pushpin. You can click any tab title to 
temporarily display the groups, then click a ribbon command or click away from the 
ribbon to hide the groups again, or click the Pin The Ribbon button to permanently 

redisplay the groups. 
KEYBOARDSHORTCUT:- Press Ctrl+F1 to unpin or pin the ribbon.  

 
 Status bar: - Across the bottom of the program window, this bar 

displays information about the current document and provides access to certain program 
functions. 
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Figure 5-The status bar. 

By default, Word displays the Page Number, Word Count, Spelling And Grammar 
Check, and Macro Recording indicators at the left end of the status bar. Each of these 
indicators on the left displays at a glance the status of that feature; clicking any of these 
indicators displays the related pane or dialog box. 

 
At the right end of the status bar, Word displays by default the View Shortcuts, 

Zoom Slider, and Zoom Level controls. The View Shortcuts toolbar includes buttons for 
the three primary document content views. The Zoom Slider and Zoom Level controls 
enable you to adjust the magnification of the active document. 

You can display the content of the active document in five views: Draft view, 

Outline view, Print Layout view, Read Mode view, and Web Layout view. All views 
are available from the View tab; Read Mode, Print Layout, and Web Layout views are 
available from the View Shortcuts toolbar on the status bar. You carry out most of the 
development work on a document in Print Layout view, which is the default. 

 Working with the ribbon:- 
As with all Office 2013 programs, the goal of the ribbon is to make working with 

document content as intuitive as possible. The ribbon is dynamic, meaning that as its 
width changes, its buttons adapt to the available space. As a result, a button might be 
large or small, it might or might not have a label, or it might even change to an entry in a 
list. 

 
 

 

 

 

 

Figure 6- The Ribbon 

2.3 Creating new document 
When you start Word2013, you can open an existing documentor create a new 

document. When you create a new document—either a blank document or one based on 
a populated template—a blinking cursor shows where the next character you enter will 
appear. When the cursor reaches the right margin, the word you are entering moves to 
the next line.You press the Enter key only to start a new paragraph,not a new line. 

 
Steps to create a New Blank document 

1. Select File->New 
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2. Select Blank Document from listed Templates 

3. Click on Create 

 

Figure 7- The New page of the Backstage view provides access to document  
Templates saved locally (on your computer) and online. 

2.4 Saving a 

Document 

Each document you create 
is temporary, indicated by a file 
name such as Document1, until you 
save it. To save a document for the 
first time, you click the Save button 
on the QuickAccess Toolbar or click 
Save in the Backstage view. Either 
action displays the Save As page of 
the Back stage view, where you can 
choose a storage location, assign a 
name, attach metadata tags, and 
specify a file type for the document. 

When you choose a 
location on the Save As page, the 
Save As dialog box opens 
displayingthat location in the 
Address bar at the top of the dialog box. If you want to save the document in a folder other 
than the one shown in the Address bar, you can click the arrow orchevrons in the Address 
bar or click locations in the Navigation pane on the left to display the folder you want. If 

Figure 8- The Save As page of the Backstage view provides links to 
identify existing and new locations in which to save documents. 
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you want to create a folder in which to store the document, you can click the New Folder 
button on the toolbar. 

But when someone wants to create a duplicate of the current document in same 

or different location, Save as ….. is 

used from File menu.   

2.5 Opening a 

document 

Click the Open page tab. This 
page displays locations from which you 
can open existing documents as well 
as a list of the documents you recently 
worked on. The content of the Places 
list varies based on your available 
resources.  

TIP By default, the Recent 

Documents list displays a maximum of 

20 documents. You can change this 

number on the Advanced page of the 

Word Options dialog box. 

 
 

2.6 Closing a Document 

As you know Microsoft word is an application in Windows, which allows to open 

multiple documents at a time side by side. Closing represents to close the active 

document which can be done by  

1. Click theFiletab, and then click Close.  
2. Or, pressCtrl+W. 
3. Or, Press Ctrl+F4(Function key) 
4. Or, Click on the Close Button from the Document Window. 
 

2.7 Exiting  Word 

Exit Word means to close all documents from the Application Microsoft word and 

Close the Application. This can be done by  

1. Click theFiletab, and then click Exit.  

2. Or, Press Alt+F4(Function key) 

Or, Click on the Close Button from the Document 

Figure 9-The Openpage of the Backstage view provides inks 

to locations from which you can open existing documents. 
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2.8 Navigation in a Document 
Navigation means 

the way of cursor 

movements in a document 

efficiently to work more 

effectively. 

2.8.1 Navigation 

with   Keyboard 

These keyboard 

shortcuts help you to move 

in a document faster and 

easily so that you can work 

more efficiently. 

2.8.2

 Navigation 

with GO TO 

 On the Home tab, 

in the Editing group, click 

the Find arrow (not the 

button), and then click Go 

To to display the Go To 

page of the Find and Replace dialog box. 
KEYBOARD SHORTCUT  Press Ctrl+G to display the Go To page of the Find And Replace 

dialogbox. 

 

 
 

 

 

 

 

 

Figure 10- Go to in Find and Replace Box 

Table 1- List of Keyboard shortcuts for Navigation 
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CHAPTER-3 

Template  

3.1 Working with  Template 

When it comes to maximizing your efficiency while creating documents in 

Word, styles and templates are among the most powerful tools available to you. 

A template that already contains the text, character and paragraph styles, page 

formatting, and graphic elements that you generally use in that type of document.  

3.2 Creating and attaching templates 

Although Most Word users rarely need to concern themselves with the 

fact, all 

Word 

documents 

are based 

on 

templates. 

New blank 

documents 

are based 

on the 

built-in 

Normal 

template, 

which 

defines 

paragraph 

styles for 

regular text 

paragraphs

, a title, and 

different 

levels of 

headings. It 

also defines a few character styles that you can use to change the look of 

selected text. These styles appear in the Styles pane and are also available in the 

Styles gallery on the Home tab. You can apply these template styles to format 

the content in the document. When you want to quickly create an effective, 

visually coordinated document, the best choice is to use Template. Most are for 

 
Figure 11- Featured templates on the New page of the  

Backstage view when working Online 
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specific types of documents, and many are pre-populated with text, tables, 

images, and other content that you can modify to fit your needs. A few of the 

templates are installed on your computer with Word. Many more templates are 

maintained on the Microsoft Office website, but you can locate and use them 

directly from with in Word (provided you have an Internet connection). You can 

create a document based on one of these templates from the Start screen or 

from the Newpage of the Backstage view. 

 

 
Figure 12- Content on the New page of the Backstage view when working offline. 
 

3.3 Save a Word document as a template 

A template is a document type that creates a copy of itself when you open it. In Word, 

you can create a template saving a document as a .dotx file, .dot file, or a .dotm file (a 

.dotm file type allows you to enable macros in the file). 

3.3.1 Save as a template 

You can start with a blank document and save it as a template, or you can create 

a template that is based on an existing document or template. 
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3.3.1.1 Start with a blank template 
1. Adjust your styles, margins, etc. in a BLANK document. 

2. In the File Ribbon, select Save As, then click on the Browse button. A 

dialogue box will come up. The Save as Type dropdown defaults to 

.docx. In order to save the file as a template, you can use either the .dotx 

or .dotm format. 

 3.3.1.2 Create a template based on an existing document 

To make a template based on a document you already created, follow these 

steps: 

1. Find the document. 

Choose one that has styles or formats or text that you plan to use repeatedly.  

2. Strip out any text that doesn’t need to be in every document.  
The template should contain only the styles you need for that document, plus any 

text that's common to all documents.  

3. Click the File tab. On the File screen, choose the Save As command. 

Don’t worry about choosing the document’s location. All Word templates are saved in a 
predefined folder, and Word automatically chooses that location for you. Click the Browse 

button. The Save As dialog box appears. It’s the same Save As dialog box that Word 

uses for saving everything.Type a name for the template.Type the name in the File Name 

box. Be descriptive. You don’t need to name the template by using the word template.  
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4. Saving Template. 

From the Save As Type drop-down list, choose  Word Template. Click 

the Save button. Your efforts are saved to disk as a document template, nestled 

in the proper place where Word keeps all its document templates. 

5. Close the template. 

The reason for closing it is that any changes you make from now on are 

made to the template. If you want to use the template to start a new document, 

you choose that template from the New window. 
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CHAPTER-4 

Edit and Proofread text 

4.1 Selecting Text 
Besides entering text, selecting text is probably the most common task for most 

Word users. Almost every task begins by selecting something. Perhaps that's why there 

are so many ways to select text.  

4.1.1Selecting text with KeyBoard and Mouse 

1. Click and drag:-Probably the most intuitive and common way to select text is to 

click and drag the mouse in any direction. 

2. [Shift]+arrow:- To move one character or one line at a time, hold down the 

[Shift] key while pressing the right and left arrow keys and the up and down arrow 

keys, respectively. 

3. [Shift]+[Home] | [End]:-Pressing [Shift] + [Home] selects everything from the 

insertion point to the left margin in the current line. Similarly, [Shift]+[End] selects 

everything from the insert point to the last character to the right. 

4. Double-click:-To select the current word, double-click it. Word will select to the 

left and right of the cursor, until it encounters a space character. 

5. Triple-click:-A triple-click selects the current paragraph. 

6. Margin+click:-To select an entire line, move the cursor into the left margin. 

When you see the insertion pointer turn into an arrow pointer, click. Doing so will 

select the current line. You can also press [Home]+[Shift]+[End], but doing so is a 

bit awkward. 

7. Margin+click and drag:-This selection method is similar to the previous one. If 

you drag while holding down the mouse, Word will select multiple lines, even 

paragraphs. Word will stop selecting when you stop dragging. 

8. [Ctrl]+A:-Pressing [Ctrl]+a selects the entire document. 

9. [Ctrl]+click:-To select a sentence (not just a line), hold down [Ctrl] and click any 

place within the sentence. 

10. Click+[Shift]+click:-To select a block of text, click at one end of the block. Then, 

hold down the [Shift] key and click a second time at the opposite end of the 

block. 

11. [Alt]+drag:-This combination selects a vertical block. While holding down [Alt], 

click and drag up or down. (You must press [Alt] first.) 

12. Selection+[Ctrl]+selection:-To select two noncontiguous blocks of text, select 

the first bit of text. Then, hold down [Ctrl] while you select the next, and the next, 

and the next - use it to select two or several non-contiguous areas. (I probably 
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use this one more than any other besides click and drag - it's great for applying 

the same format to several spots.) 

13. [Ctrl]+[Shift]+[Right arrow] | [Left arrow]:-Use this combination to select from 

the current position to the right or left of the current word, depending on whether 

you press the right or left arrow, respectively. 

14. [Ctrl]+[Shift]+[Up arrow] | [Down arrow]:-This combination selects from the 

current position to the beginning or ending of the current paragraph, depending 

on whether you press the up or down arrow, respectively. 

15. [Alt]+[Ctrl]+[Shift]+[Page Up] | [Page Down]:-This is another awkward 

keystroke combination that selects from the current insertion point to the 

beginning or the ending of the current window (what you see on the screen), 

respectively. This one's awkward enough that I'd probably use a quick click and 

drag instead. 

4.1.2 Selecting Text with F8(Function key) 

Word remains in Extended Selection mode until you do something with the block or 

you press the Esc key to cancel Extended Selection mode. 

To cancel the extended selection, press the Esc key. This action ends Extended 

Selection mode and keeps the block of text marked. 

1. You can use the mouse and the F8 key to get fancy. Position the cursor at 

either end of the block you want to mark, and press the F8 key. Then position 

the mouse cursor at the other end of the block, and press the left mouse 

button. Everything from there to there is marked. 

2. After pressing the F8 key, you can use the Find command to locate a specific 

bit of text. Word marks all text between the spot where F8 was pressed (the 

anchor) and the text that the Find command locates. 

3. Press the F8 key twice to select the current word. 

4. Press the F8 key thrice to select the current sentence. 

5. Press the F8 key four times to select the current paragraph as a block of text. 

6. Press the F8 key five times to select the entire document, from top to bottom. 

7. No matter how many times you press F8, be aware that it always drops 

anchor. So pressing F8 once or five times means that Word is still in Extended 

Selection mode. Do something with the block or press Esc to cancel that 

mode. 

4.2     Changing Case 

To change the case of selected text in a document, do the following: 

1. Select the text for which you want to change the case. 
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2. On the Home tab, in the Font group, click Change Case. 

Or. You can use F3(Function key) 

3. Choose an option from the dropdown list, which includes Sentence case, 

lowercase, UPPERCASE, Capitalize Each Word, and tOGGLE cASE. Notes. 

4.3 Editing text 
Editing documents in Word is just as simple as entering text in a blank document. 

By clicking within the body of the document, you can add text. By default, Overwriting is 

turned off, which means text to the right of the insertion point will be moved to the right. 

It is important to note, however, that if you highlight part of your document and then 

start typing, the highlighted portion will be deleted and the new text will appear in its 

place; it doesn’t matter whether you have hard returns, images, tables, or text 

highlighted, the results will be the same. In the event you accidentally delete part of your 

document, you can use the Undo feature (ctrl+z)- to undo up to 100 changes you have 

made to your document. If  you want to delete portions of your document, you can simply 

highlight the portion you would like to delete and press thedeletekey; unless you’ve 

changed Word options, Word will automatically correct the spacing at the point of the 

deletion.  

To delete individual elements of your document, you have two options:  

The deletekey will delete objects to the right of the insertion point, while the 

backspace key will delete objects to the left of the insertion point. 

4.4 Moving and Copying Text and Objects 
Perhaps the most important benefit of word processing over typewriter use is the 

ability to move and copy objects and blocks of text. There are many ways of 

accomplishing move and copy operations in Word, so you can select whatever method is 

most comfortable for you or makes the most sense in a particular situation. The following 

sections explain the various move and copy operations and the differences between 

them. 

4.4.1 Moving or Copying Text with Drag-and-Drop 
Drag-and-drop operations are popular because 

they most closely resemble the way you do things outside 

the computer. (Yes, there really is a life outside the 

computer!) When you want to move something in your 

living room, you pick it up and reposition it. Or if it's 

heavy, like a piece of furniture, you drag it and drop it. 

You can do the same thing with objects and with blocks of 

selected text in Word. 

For a standard drag-and-drop operation, follow 

these steps: 

1. Select the text or object(s) you want to move or copy. 

Figure 14- Additional Drag and 
Drop option Box 
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2. To copy, hold down the Ctrl key. You don't have to hold anything down if you 

want to move. 

3. Position the mouse over the selection, and then click and hold down the left    

mouse button on it. 

4. Still holding down the left mouse button, drag the selection to a new location. 

Then release the mouse button. 

There are additional drag-and-drop options; to see them, use the right mouse 

button rather than the left one in the preceding steps. (Don't hold down the Ctrl key if you 

are using the right mouse button.) When you release the mouse button in step 4, a 

shortcut menu appears with these choices on it: 

 Move Here—The default operation; the same as regular dragging with the left 
mouse button. 

 Copy Here—The same as holding down the Ctrl key with the left-mouse-button 
drag. 

 Link Here—Creates a copy that retains a link to the original location, such that if 
the original changes, this copy changes too. 

 Cancel—Cancels the current drag-and-drop operation. 

4.4.2 Using Cut, Copy, and Paste 
One of the complaints that many people have with drag-and-drop is that they are 

simply not coordinated enough to manage positioning the mouse pointer in exactly the 

right spot while holding down keys and mouse buttons. People who have this problem 

may prefer to use the Cut, Copy, and Paste commands instead. 

Cut and Copy are very similar operations. Cut removes the selection from the 

document and places it on the Clipboard, which is a hidden holding area; Copy leaves 

the selection as is and places a copy of it on the Clipboard. After a Cut or Copy 

operation, you can then use Paste to place the Clipboard's content at the insertion point 

location. 

There are actually two Clipboards—the Windows Clipboard and the Office 

Clipboard. The Windows Clipboard holds only one item at a time; when you place a 

second item on that Clipboard, the first item is erased from it. The Office Clipboard has 

multiple slots for holding content. It uses the Windows Clipboard for one slot, but it can 

also hold 23 other items at the same time. I explain more about the Office Clipboard later 

in the chapter. 

Word offers ribbon, keyboard, and right-click methods for issuing the Cut, Copy, 

and Paste commands.  
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Cut, Copy, and Paste Methods 

 Cut Copy Paste 

Click these buttons 

on the Home tab: 
  

 

Press these 

shortcut keys: 

Ctrl+X Ctrl+C Ctrl+V 

Right-click your 

selection and then 

choose one of these 

commands: 

Cut Copy Paste 

TIP:- Experienced users generally end up using the keyboard shortcut 

methods most frequently because they are the fastest. 

If you would like to save something from the Clipboard 

so that it can be used later, but you don't want to save it in 

Word 

The Paste Special command enables you to define the 

format of the pasted copy, and in some circumstances also 

create a dynamic link to the original. 

To use Paste Special instead of Paste, open the drop-

down menu below the Paste button and select Paste Special from 

that menu, as in Figure 15. 

 Use the Paste Special dialog box to paste in a different way than the default. 

For a normal (nonlinked) paste, select a paste format from the As list. The choices 

on the list depend on the type of content you cut or copied. For example, if you copied 

some text from another document that had some unusual formatting, you could choose to 

keep that formatting by selecting Formatted Text (RTF), or you could choose to discard 

that formatting by selecting Unformatted Text. 

Figure 15- Paste Special  drop 
down list 
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If you paste text in one of the Picture formats, it is no longer editable as text; you 

can edit it only with a picture-editing program. 

Pasting in a format whose name ends with "Object" creates an embedded copy 

that retains its link to the original program. This is not especially relevant for copying text 

within and between Word documents because the original program is Word itself, but it 

makes a difference when copying multimedia content, such as graphics from a graphics 

program, into Word, for example. When 

you choose an "Object" format, the 

selection is placed in its own separate 

frame from the rest of the document, 

and you can edit that object in its native 

program later by double-clicking it. 

Under some circumstances, a 

Paste Link option is also available. For 

Paste Link to be available, the selection 

must have been copied from some 

other document or file than the one in 

which it is being pasted, and the 

document/file from which it came must 

have been saved at least once (so it 

has a filename, not just the generic 

"Document1" name a file gets before it is saved).  

4.4.3 Paste Link Text/Object 

Paste Link creates a dynamic link between the original and the copy so that when 

the original changes, the copy also changes. 

Don't use Paste Link unless you can actually benefit from it, because it makes the 

file size larger, and if the original file ever is deleted or moved, an 

error message will appear in the file containing the copy. 

4.4.4 Using Paste Options 

After you have pasted something in Word, a Paste Options 

button appears next to it. You can click this button to open a 

menu of choices governing the paste operation, as shown 

in Figure . Here are the choices: 

 Keep Source Formatting—The object retains its look 

from its original location. 

 Match Destination Formatting—The object is stripped 

of any previous formatting and the formatting of the new location 

is applied. 

 Keep Text Only—The object is stripped of any previous 

formatting and remains stripped in the new location. 

Figure 16 Paste Special Dialog Box 

Figure 17- Paste Options 
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4.4.5 Advanced Paste Special Options 

 Choose options for the paste operation just performed. 

The Set Default Paste… command opens the Word Options dialog box (same as 

Office, Word Options) and displays the Advanced options. From here you can set a 

variety of paste options in the Cut, Copy, and Paste section. 

 Pasting Within the Same Document—Choose how formatting is applied to the 

copy when copying within a document. You can choose Keep Source Formatting, 

Match Destination Formatting, or Keep Text Only. 

 Pasting Between Documents—Choose how formatting is applied to the copy 

when styles are not an issue (for example, when both the source and destination 

use the same style defined the same way). 

 Pasting Between Documents When Style Definitions Conflict—Choose how 

formatting is applied to the copy when you are copying between documents and 

the style applied in the source document differs from that applied at the insertion 

point location in the destination document. 

 Pasting From Other Programs—Choose how formatting is applied to the copy 

when the text is coming from some other application than Word. 

 Insert/Paste Pictures As—Choose how non-text objects are placed in the 

document. In Line with Text means the object is treated as a text character at the 

insertion point, and will move with the surrounding text. The other options are all 

various wrapping settings for floating objects. 

 Keep Bullets and Numbers When Pasting Text with Keep Text Only 

Option—Just like the name says. If you have set one of the previous settings to 

Keep Text Only, but you are copying a bulleted or numbered list, this setting 

determines whether the bullet or number is preserved. 

 Use the Insert key for Paste—Mark this if you want the Insert (Ins) key on the 

keyboard to be remapped to be a shortcut for the Paste command. This check 

box is paired with the Use the INS Key to Control Overtype Mode check box (on 

the same tab); only one or the other can be chosen at once. 

 Show Paste Options Buttons—Clear this check box if you don't want that Paste 

Options button to appear next to pasted selections. (Sometimes it can get in the 

way.) 

 Use Smart Cut and Paste—Enables Word to apply a rather complex set of rules 

to determine how selections should be pasted. To fine-tune these rules, click the 

Settings button to display the Settings dialog box (see Figure 3.13). Note that you 

can choose default options for Word 2002-2007 or for Word 97-2000, or go your 

own way with custom settings. 
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Figure 18 Paste options are controlled in the Word Options dialog box. 

 

4.4.6 Using Clipboard 

 Use the Clipboard 

task pane to access the 

Office Clipboard's 24 

separate areas for storing 

clips. 

By default, the 

Clipboard pane is fixed in 

location and size, but you 

can click the down arrow in 

its top-right corner for a 

menu from which you can 

move and resize it. 

Each time you copy 

something to the 

Clipboard, it is added to 

the Clipboard task pane's 

list, with the most recently 

added items at the top. To 

 

Figure 19 Getting ClipBoard 
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paste an item from it, position the insertion point and then click that item in the Clipboard 

task pane. To paste all the items at once, click Paste All. 

To remove a single item from the Clipboard task pane, right-click the item and 

click Delete. (Alternatively, you can point at the item until a down arrow appears to its 

right. Click that down arrow to open the same menu as with right-clicking; then click 

Delete.) 

To clear the entire Clipboard at once, click the Clear All button at the top. Clearing 

the Office Clipboard also clears the Windows Clipboard. 

To fine-tune how the Office Clipboard works, click the Options button. A menu 

appears with these options on it: 

 Show Office Clipboard Automatically—Displays the 

Office Clipboard automatically when copying items. 

 Show Office Clipboard when Ctrl+C Pressed Twice—
Displays the Office Clipboard when Ctrl+C is pressed twice. 

 Collect Without Showing Office Clipboard—Copies 

items to the Office Clipboard but does not show the task pane 

unless you specifically call for it (by pressing Ctrl+C twice, for 

example). 

 Show Office Clipboard Icon on Taskbar—Displays an 

Office Clipboard icon in the notification area of the taskbar 

(near the clock) whenever the Office Clipboard is active. You     

can double-click that icon to display the Office Clipboard in the 

active application. (Remember, all Office apps share the Office 

Clipboard.) 

 Show Status Near Taskbar When Copying—Pops up a 

message near the Office Clipboard icon when something has   

just been copied to the Clipboard. 

4.4.7 Use F2 to Copy and Move Text 

After you select text in Word 2007, you can press F2 to copy 

the text and paste it elsewhere — even into another Word 

document you’re working on. As long as you can remember to use the F2 key, copying 
and moving a block of text by using this technique can be quite handy. 

1. Select a block of text. 

2. Click the mouse button to anchor the insertion pointer at the beginning of 

the block, drag to the end of the block (anywhere you want), and release 

the mouse button. 

3. Press the F2 key. 

4. Notice that the status bar (at the bottom of your screen) says "Move to 

where?" 

Figure 21 Clipboard 
Box 

Figure 20 Delete 
from Clipboard 
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2 

5. Place the insertion pointer wherever you want to move (paste) the block of 

text. 

6. Press the cursor keys or scroll with the mouse. Wherever you place the 

insertion pointer is where the text will be moved. 

7. Press Enter to paste the text. 

8. The block of text is moved, just as though you had typed it there yourself. 

4.5 Finding and replacing text 

One way to ensure that the text in your documents is consistent and accurate is to 

use the Find feature to search for and review every occurrence 

of a particular word or phrase. 

Clicking the Find button in the Editing group on the 

Home tab displays the Results page of the Navigation pane. 

As you enter characters in the search box at the top of the 

pane,Word highlights all occurrences of those characters in the 

document and displays them on the Results page. 

KEYBOARDSHORTCUT:-Press Ctrl+F to   activate the 

search box. 

When you point to a search result on the Results page, 

a ScreenTip displays the number of the page on which that 

result appears and the name of the heading preceding the 

search result.You can click a search result to move directly to 

that location in the document. 

TIP-The Results page of the Navigation pane allows 

you to continue editing your document as you normally 

would, while still having access to all the search results. 

If you want to be more specific about the text you are 

looking for—for example, if you want to look for occurrences 

that match the exact capitalization of your search term—click 

the Search For More Things arrow at the right end of the 

search box in the Navigation pane and then click Advanced 

Find to display the Find page of the Find And Replace dialog 

box. Clicking More in the lower-left corner expands the dialog 

box to make additional search options available. 

 

Figure 22- Results page of the 
Navigation pane 
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You can make a search more specific by using the criteriain the Search Options 

area of the Find page. 

 

In the expanded 

dialog box, you can do 

the following: 

 Guide the 

direction of the 

search by selecting 

Down, Up, or All 

from the Search 

list. 

 Locate only text 

that matches the 

capitalization of the 

search term by 

selecting the Match 

Case check box. 

 Exclude 

occurrences of the 

search term that 

appear with in other 

words by selecting 

the Find Whole Words Only checkbox. 

 Find two similar words, such as effect and affect, by selecting the Use Wild 

cards check box and then including one or more wild card characters in the search 

term. The two most common wildcard characters are the following: 

 ? Represents anysingle character in this location in theFind What text 

 * Represents any number of characters in this locationin the Find What text 

TIP For a list of the available wildcards, select the Use Wildcards check box and then 

click Special. 

 Find occurrences of the search text that sound the same but are spelled differently, 

such as there and their, by selecting the SoundsLike checkbox. 

 Find occurrences of a particular word in anyform, such as try, tries, and tried, by 

selecting the FindAll WordForms checkbox. 

 Locate formatting, such as bold, or special characters, such as tabs, by selecting 

them from the Format or Special list. 

 Locate words with the same beginning or end as the search term by selecting the 

Match Prefix orMatch Suffix checkbox. 

Figure 23 Find and Replace Dialog box 
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 Locate words with different hyphenation or spacing by selecting the Ignore 

Punctuation Characters or Ignore White-Space Characters checkbox. 

If you want to substitute a specific word or phrase for another, you can use the 

Replace feature. Clicking the Replace button in the Editing group on the Home tab 

displays the Replace page of the Find And Replace dialog box. 

 
KEYBOARDSHORTCUT:-Press Ctrl+H to display the Replace page of the Find And Replace 

dialog box. 

 
TIP-If the Navigation pane is open, you can click the Search For More Things arrow at the right 

end of the search box and then click Replace. The Find And Replace dialog box opens with the search 

term from the Navigation pane already in the Find What box. 

 

Figure 24 Correcting errors and in consistencies is easy withthe Replace feature. 
 
 
For each instance of the search term that Word locates, you can click one of the 

following choices on the Replace page: 

 

▪Replace:-Replaces the selected occurrence with the text in the Replace With box 

and moves to the next occurrence 

▪Replace All:-Replaces all occurrences with the text in the Replace With box 
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TIP Before clicking Replace All, ensure that the replacement is clearly defined. For example, if 

you want to change trip to journey, be sure to tell Word to find only the whole word trip; otherwise, 

triple could become journeyle. 

▪Find Next:-Finds the first occurrence or leaves the selected occurrence as it is 

and 
Locates the next one 
 

 

Figure 25 From this menu, you can locate specific types of objects and also refine text 
searches. 

 
 

 
Figure 26- The Find Options dialog box contains most options for refining the current search, 

other than the style and special character options. 
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4.6 Correcting spelling and grammatical errors 

In the days of handwritten and typewritten documents, people might have 

tolerated a typographical or grammatical error or two because correcting such 

errors without creating a mess was difficult. Word-processing programs such as 

Word have built-in spelling and grammar checkers, so now documents that contain 

these types of errors are likely to reflect badly on their creators. 

 

 

TIP Although Word can help you eliminate misspellings and grammatical 

errors, its tools are not infallible. You should always read through your 

document to catch any problems that the Word tools can’t detect—for 

example, homonyms such as their, there, and they’re. 

 

Word provides these three tools to help you with the chore of eliminating spelling 

and grammar errors: 

▪ AutoCorrect This feature corrects common spelling and grammatical errors, 

replaces text codes with mathematical symbols, and automatically applies 

formatting based on text cues. AutoCorrect has a built-in list of frequently 

misspelled words and their cor- 

rect spellings. If you frequently misspell a word that AutoCorrect doesn’t change, 

you can add it to the list in the AutoCorrect dialog box. If you deliberately enter a 

word that is on the AutoCorrect list and don’t want to accept the AutoCorrect change, 

you can reverse the correction by clicking the Undo button before you enter anything 

else, or by pointing to the bar that appears below the word and then clicking Undo. 

▪ Error indicators Word indicates possible spelling errors with red wavy 

underlines, possible grammatical errors with green wavy underlines, and possible 

formatting 

errors with blue wavy underlines. You can right-click an underlined word or phrase 

to display suggested corrections and links to proofing resources. 

▪ Spelling and grammar checker To check the spelling or grammar of selected 

text or the entire document, click the Spelling & Grammar button in the Proofing group 

on the Review tab. Word then works its way through the selection or the document 

and displays the Spelling pane or Grammar pane if it encounters a potential error. 

KEYBOARD SHORTCUT Press F7 to start checking the spelling and grammar from 

your current location in the document. 

The pane that appears displays an explanation of the likely problem and suggests 

corrections. You can implement a suggestion by double-clicking it. 
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4.6.1 Check spelling and grammar 
All Microsoft Office programs can check the spelling and grammar of your files. In 

Microsoft Word 2013 you’ll find 
the Spelling & 

Grammar options here: 

 Click Review > Spelling & 

Grammar (or press F7) to start 

the spelling and grammar 

checker and see the results in 

the Spelling and 

Grammar task pane. 

           TIP   If you prefer to use the keyboard to review the results, press the 

underlined letter found on the buttons in the task pane. For example, to Ignore 

All  instances of a word, press g. 

Choose from these options as the spelling and grammar checker goes through 

each word: 

1. Check the spelling and grammar all at once. 

2. Check spelling and grammar automatically, as you type. 

3. Recheck the words you previously checked and chose to ignore (but changed 

your mind). 

4.6.2 Check spelling and 

grammar all at once 

Checking all the spelling and grammar 

in your document is useful when you 

want to quickly proof your text. You 

can check for possible mistakes and 

then decide if you agree with the 

spelling and grammar checker.After 

you click Spelling & Grammar (or 

press F7) you can fix each error that 

Word finds in different ways. In the 

task pane at the right of your 

document, you will see the spelling 

Figure 27 Spelling and Grammar Option 

Figure 28 Spelling Box 
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and grammar choices: 

TIP   If you prefer to use the keyboard to review the results, press the underlined letter found on 

the buttons in the task pane. For example, to Ignore All  instances of a word, 

press g. 

 Fix the error using Word’s suggestions    If you want to fix the error by using 

one of the suggested words, select the word in the list of suggestions and 

click Change. (You can also click Change All if you know you’ve used this 
incorrectly spelled or used word throughout the document so that you don’t have to 
address it each time it pops up.) 

 Create a dictionary entry    If the word is a real word that you use and one that 

you want Word—and ALL of the Office programs—to recognize too, click Add. 

 Ignore the word    Maybe you want to ignore this misspelled word (for whatever 

reason): Click Ignore or Ignore All. 

4.6.3 Check spelling and 

grammar automatically 

Checking spelling and grammar while 

you type may be a preferred way for 

you to save time: You make the 

necessary corrections and 

changes while you’re writing, not 
waiting until after (you think) your 

document is complete. 

1. First, to turn on (or off) automatic 

spelling and grammar checking, 

click File > Options > Proofing. 

2. As you can see in the picture 

above, you can choose to 

automatically check spelling, 

grammar—one or the other, both, 

or neither—or even other options, such as contextual spelling. 

3. Under Exceptions you can choose to hide grammar and spelling errors in 

your open document or, if you leave the options unchecked but keep any of 

the options above them checked, all of your new documents going forth will 

keep those settings. 

Figure 29 Spelling and Grammar setting options 
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4.6.4 How the automatic spelling checking works 
Word flags misspelled words with a red squiggly line under it as you work so that 

you can easily locate mistakes: 

 

When you right-click the misspelled word, you’ll see a menu where you can choose 
how you want to handle the mistake. 

 

                                Figure 30  Optiions menu on right clicking 

4.6.5 How automatic grammar checking works 

After you turn on automatic grammar checking, Word flags potential grammar, 

style, and contextual mistakes with a blue squiggly line under the word, term, or 

phrase as you work in your document. 
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Just like with the spell checker, you can right-click the mistake to see more options. 

(In this case, the sentence might have been better off as a question instead of a 

sentence. 

4.6.6 Recheck the words and grammar that you 

previously checked and chose to ignore 

You can also force a recheck of the words and grammar that you previously chose 

to ignore. 

1. Open the document that you want to recheck. 

2. Click File > Options > Proofing. 

3. Under Correcting spelling and grammar in Word, click Recheck Document. 

4. When you see the following message This operation resets the spelling 

checker and grammar checker so that Word will recheck words and 

grammar you previously checked and chose to ignore. Do you want to 

continue? click Yes and then click OK to close out of the Word Options dialog 

box. 

5. Then, in your document, click Review > Spelling & Grammar (or press F7). 

4.7 Automatically insert text 

There’s more than one way to automatically enter text in Word. 
You can insert blocks of preformatted text using AutoText from your AutoText 

gallery. This is useful, for example, when you need to repeatedly enter the same large 

block of text and the text contains a lot of formatting. You create AutoText entries by 

adding selected text to the AutoText gallery. 

Word can also automatically complete a word, phrase, or sentence for you after 

you’ve typed only a few characters. To do this, you first add the text entries in the 
AutoCorrect dialog box. 

This can be done by two ways- 

 Auto Correct and Auto Format 

 Auto Text 

4.7.1 AutoCorrect and Auto Format 
 

To automatically correct common errors as you type, use the options in the 

AutoCorrect tab of the AutoCorrect dialog box to set up automatic correction of 

capitalization errors and commonly misspelled words. You can also create special 

characters. Various options are preset with Word, but you can delete and modify 
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existing entries. This document discusses the options available and how to make 

changes. 

Accessing the AutoCorrect Dialog Box 
1.   From the File tab, click Options to open Word Options. Select Proofing on 

the left. 
 
 
 
 
 

 
 
 
 

 
 
2.   The AutoCorrect options dialog box 
appears, click the Autocorrect tab. 

 
 
Selecting/Deselecting AutoCorrect Options 

 
You can use the AutoCorrect options that are 
appropriate for your work while turning off the 
others. This table below shows the options and 
the automatic corrections Word makes when 
they are selected. These options can also be 
changed through the use of smart tags. 
 
1. The AutoCorrect options are preceded by 

checkboxes. 
2. Select the options you want to activate or 

not. A checkmark in the box indicates an 
option is selected and active. 

3. Click OK to save changes. 

Figure 31 Options for Auto Correct 

Figure 32 Auto Correct Dialog Box 
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The AutoCorrect dialog box offers the following customization options. 

 

 

 Accidental usage of Caps Lock key correction: 
Correction occurs if the first letter is typed lowercase and following letters are 

uppercase, which is the case when Caps Lock is on and you press [Shift] to capitalize 
the first letter of a word. The correction makes the first letter uppercase and then turns 
off the Caps Lock. No correction will occur if the first letter is typed in caps. 

 

 Creating Exceptions to AutoCorrect Options 

The AutoCorrect feature can save you time during editing. However, if you have 

special abbreviations or company names that are exceptions to the rules Word uses in 

determining corrections, the AutoCorrect feature may seem like a nuisance. Word 

allows you to record these exceptions so you can take advantage of the AutoCorrect 

feature without worrying about words or phrases particular to your work. 

 First Letter 

Word normally capitalizes the next word after a period and a space. For example, if 

you use  the abbreviation num. for number and type num. five, Word will correct it to 

num. Five. You can record your abbreviation as an exception so Word will not make the 

Table 2 Auto Correct Options 
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correction. 

 INitial Caps 

Word will automatically correct two initial capital letters. However, if you use a word or 

company name that has two initial capital letters, you would not want the correction 

made. For example, if you correspond with a company called REmax, when you type 

the name, Word will correct it to Remax. You can record a name or term as an 

exception so Word will not correct it. 

Word does not correct two initial capital letters followed by a lowercase s (e.g., RNs). 

 
To record exceptions: 

 
1.   Access the AutoCorrect dialog box. Select the AutoCorrect tab 
2.   Click Exceptions... The AutoCorrect Exceptions dialog box appears. 
3.   Select the appropriate tab 
4.   In the text box, type your exception. Click Add then click OK twice. 

 
Overriding AutoCorrect 

Word may sometimes automatically "correct" a word or phrase that you do not want 
changed. If you do not use the word often enough to warrant creating an exception, you 
can undo the individual AutoCorrection without changing AutoCorrect settings. You 
may also use this method to override AutoFormatting such as bulleted and numbered 
lists. 

 
1.   Move your mouse over the AutoCorrected word. A small rectangle appears under 

the first letter. 

2.   Move your mouse over this rectangle. A Smart Tag appears. Click the            to 
select the desired AutoCorrect option 

Your options and the implications are listed here, 
using the example of automatically correcting a 
misspelled word. 

 
Some AutoCorrect options include: 
Undo Automatic Capitalization - Selecting this 
option affects only this occurrence of the 
capitalization in the current document 

Stop Auto-capitalizing First Letter of Sentences - Selecting this option corrects this 

occurrence and turns off this option for all documents 

Control AutoCorrect Options - Selecting this option takes you to the AutoCorrect 
dialog box, where you can choose from multiple AutoCorrect options that will affect all 
documents 

 
Creating Replacement Text Entries 

Figure 33 Control Auto Correct option 
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Word provides several preset entries for commonly used plain text, formatted text, and 
misspelled words. In the AutoCorrect dialog box, you can view the list of preset entries 
by scrolling through the list. What you type appears on the left and Word's replacement 
text appears on the right. If you regularly use the copyright symbol or misspell words like 
achieve and knowledge, you will want to select this option. Word's preset entries can be 
added to, modified, or deleted, depending on your needs. 

 
Considerations: 

 
 If the name is typed in lowercase, it is not case sensitive. 

  If the replacement text contains at least one uppercase letter, typing the text in 
all lowercase will not convert it completely. 
 AutoCorrect can correct only one problem at a time. 
EXAMPLE: If you are trying to type "America" and type "ameria," the 
AutoCorrection would be "Ameria." The AutoCorrect will only correct the 
capitalization and will not correct the spelling error. However, if you later use the 

spell checker, the spelling error will be detected. 
 

 

When creating replacement text entries, two 
options are available: plain text and formatted 
text. The plain text is primarily phrases, while 
the formatted text can often be symbols. For 
formatted text, you must first select the text. 

 
Creating a Replacement Text Entry: Plain 
Text 

 

If you frequently type the same phrase in 

many of your Word documents, you can 

create a replacement text entry and save 

keystrokes. 

 
1.   Access the AutoCorrect dialog box. 
Select the AutoCorrect tab 
2.   In the Replace text box, type the 
keystrokes to be replaced - Type DC 

Figure 34 Creating Auto Correct  Entry 
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3.   In the With text box, type the words to be used as replacement text – 
Dickinson College 

4.   Click Add then click OK 
Each time you type the keystrokes followed by [Space] or [Enter] they will be 
replaced by the text you specified.  If desired, you can override the AutoCorrect 
options. Click OK 

 
 
Creating a Replacement Text Entry: Formatted Text 

 
If you regularly use a symbol in your documents, you can define the symbol as 
replacement text. 

 
Considerations: 

 
  If formatted text is selected, the symbol (or text) you selected in your document 

will retain its formatting (e.g., font and size). 

  If you select Plain text, what you have selected in your document will be stored 

without formatting and will assume the formatting of your document when later 

inserted as replacement text. 

  These options are available only when you are working with a selection in your 

document. 

 

1.   From the Insert command tab, in the Symbols group, select Symbol, select 

More 

Symbols. The Symbol dialog box appears. Select the desired symbol 

2.   Click Insert then click Close. Select the symbol you just inserted 

3.   Access the AutoCorrect dialog box. The AutoCorrect dialog box appears. 

4.   Select the AutoCorrect tab. The selected symbol appears in the With text box. 

5.   Select Formatted text or Plain text 

6.   In the Replace text box, type the keystrokes to be replaced by the symbol 

7.   Click Add then Click OK 

Each time you type the keystrokes followed by [Space] or [Enter] they will be 

replaced by the text you specified. If desired, you can override the AutoCorrect 

options. Click OK 

Creating a Replacement Text Entry: Symbol Dialog Box Option 

1.   From the Insert command tab, in the Symbols group, select Symbol, select 

More Symbols. The Symbol dialog box appears. Select the desired symbol 

2.   Click Autocorrect. The AutoCorrect dialog box appears. 

3.   In the Replace text box, type the keystrokes to be replaced by the symbol 

4.   Select Formatted text or Plain text 
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5.   Click Add then Click OK. The Symbol dialog box appears. Click Close 

Each time you type the keystrokes followed by [Space] or [Enter] they will be 

replaced by the text you specified. 

 

Editing a Replacement Text Entry 

You can make changes or corrections to your replacement text entries. 

1.   Access the AutoCorrect dialog box. The AutoCorrect dialog box appears. 

2.   Select the AutoCorrect tab 

3.   From the scroll box, select the entry to be changed 

4.   In the Replace and/or With text boxes, make the desired change(s) 

5.   Click Add then click OK. Your old entry is replaced with the edited one. The 

revised entry will be used in all future text replacements. Click OK 

 

Deleting a Replacement Text Entry 

1.   Access the AutoCorrect dialog box. The AutoCorrect dialog box appears. 

2.   Select the AutoCorrect tab. 

3.   From the scroll box, select the entry to be deleted 

4.   Click Delete then click OK. The entry is deleted. Click OK again. 

 AutoCorrect: AutoFormat 

The AutoFormat tab applies formatting 

options in conjunction with the 

AutoFormat As You Type tab. This 

document shows you how AutoFormat 

can be turned on/off and how its 

various options affect your Word 

projects. 

 Accessing the AutoFormat 

Tab & Unique Options on the 

AutoFormat Tab 

Accessing the AutoFormat Tab 

1.   From the File tab, click Options 

2.   In the Categories pane, select 

Proofing 

3.   In the AutoCorrect options section, 

click Autocorrect Options. 

4.   Select the AutoFormat tab 

5.   Select the desired options. An 
option is selected and active when 
a checkmark appears before it.  
When finished, click OK. 
As with any AutoCorrect option, 

Figure 35 Auto Format option 
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you can override the formatting if you wish. To exit the Application Settings dialog 
box, click OK. 

Unique Options on the AutoFormat Tab 
Many AutoFormat tab options are identical to those found on the AutoFormat As You 
Type tab. The list below describes options that are unique to the AutoFormat tab. 

 
List styles - Applies list styles to numbered, bulleted, outlines, and other lists. It 
replaces any numbers or bullets that were inserted manually 
Other paragraph styles - Applies styles other than for headings and lists (e.g., body 
text) 
Preserve styles - Retains the styles you have already applied in your document 
Plain text e-mail documents - Formats e-mail messages when they are opened 

 

4.7.2 Auto Text: 
 

In order to add the auto text gallery you need to add Auto text to Quick Access 

toolbar and then add entries to gallery to auto complete your word 

In Order to add Auto text to Quick Access Toolbar 

• Go to File tab and choose Option 

• Go to Quick access section in open window and choose all command 
choose command from drop down list 

Figure 37 Auto Text Feature 

o 
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• Choose add in order to add Auto text to Quick Access tool bar then click on ok 

Now Auto text is added to your Quick Access tool bar 

In order to add a new Auto Text entry 

• Select the word that you want to add to gallery 

• Choose AutoText in Quick Access Tool bar and click Save Selection to Auto Text galley 

• You should fill out New Building Block 

 

 

 

 

 

 

 

 
 

• 

Name ch

oose 

good and unique name. 

• Gallery choose gallery which you 

want to add new entry. 

• Category choose category such as 

general or create new category. 

• Description add some description 

• Save in save place to show up 

• Options : 
• Select ‘Insert content in its own 
page’ in order to insert building 

block to a separate page 

• Select ‘Insert content in its own 
paragraph’ in order to insert 

building block to its own paragraph                                                                                       

• Select ‘Insert content only’ in 

order to insert building block to text 

Create or change an AutoText 

entry 

AutoText entries must be at least five characters long if you want to insert the entry 

by using AutoComplete. 

Create a new entry 

Figure 38 Auto Text Entry Button on Quick Access tool bar 

Figure 39 Creating a New Entry 
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1. Select the text or graphic you want to store as an AutoText entry. 

To store TE000128076 with the entry, include the paragraph mark ( ) in 

the selection. 

2. On the Insert menu, point to AutoText, and then click New. 

3. When Microsoft Word proposes a name for the AutoText entry, accept the 

name or type a new one. 

If you plan to insert the entry by using AutoComplete, make sure the name 

contains at least four characters because Word inserts an entry only after four characters 

have been typed. 

Change an entry 

1. Insert the AutoText entry into the document. 

AutoText entries are divided into categories such as Closing or Salutation. Check 

the Normal category for entries you've created unless you know they are stored under 

another category. 

a. Click in the document where you want to insert the AutoText entry. 

b. On the Insert menu, point to AutoText, and then point to the type of 

entry you want to insert. 

c. Click the name of the AutoText entry you want. 
 

Tips 

i) You can also use a shortcut to insert an AutoText entry. First, turn on AutoComplete (point 

to AutoTexton the Insert menu, click AutoText, and then select the Show AutoComplete 

suggestions check box). In your document, type the first few characters in the AutoText entry's 

name. When Microsoft Word suggests the complete AutoText entry, press ENTER or F3 to 

accept the entry.  

If the AutoText entry contains a graphic without text, press F3 to accept the entry. 

To reject the AutoText entry, keep typing. 

ii)The entries in the lists on the AutoText menu and the AutoTexttoolbar correspond to the 

language of the text that your insertion point is positioned in. For example, if you are typing 

French in the English version of Word, the AutoText entries that appear on the menu and on the 

toolbar list will be in French, but the ones on the AutoText tab in the AutoCorrect dialog box will 

be in English. 

To insert AutoText entries in the language you're typing in, use 

the AutoText menu (point to AutoTexton the Insert menu) or click All Entries on 

the AutoText toolbar. To insert AutoText entries in the language version of Word that you 

are using, use the AutoText tab in the AutoCorrect dialog box (point to AutoText on 

the Insert menu, and then click AutoText). 

Also note that if you insert an AutoText field by using the Field Options dialog box 

(Insert menu, Fieldcommand), the Field Options dialog box, like the AutoText tab, 

reflects the language version of Word that you are using, not the language you are typing 

in. 

2. Make the changes you want. 



73 

3. Select the 

revised AutoText entry. 

o To store 

TE000128076 

with the entry, 

include the 

paragraph 

mark ( ) in the  

selection. 

4. On the Insert menu, 

point to AutoText, and 

then click New. 

5. Type the original name of 

the AutoText entry. 

Rename an entry 

1. On the Tools menu, 

click Templates and 

Add-Ins. 

2. Click Organizer, and 

then click 

the AutoText tab. 

3. In the In box on the left, 

click the entry you want 

to rename, and then click Rename. 

4. In the Rename dialog box, type a new name for the entry. 

5. Click OK, and then click Close. 

Figure 40 Auto Text Options 
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CHAPTER-5 

Formatting text 
 

The appearance of your documents helps to convey their message. Microsoft 

Word 2013 can help you develop professional-looking documents whose appearance 

is appropriate to their contents. You can easily format words and paragraphs so that 

key points stand out and the structure of your document is clear. You can also change 

the look of major elements within a document by applying predefined sets of formatting 

called styles, andyou can change the look of selected text by applying predefined 

combinations called text effects. In addition, you can change the fonts, colors, and 

effects throughout a document with one click by applying a theme. 

5.1 Applying styles to text 

You don’t have to know much about character and paragraph formatting to be 

able to format your documents in ways that will make them easier to read and more 

professional looking. With a couple of mouse clicks, you can easily change the look of 

words, phrases, and paragraphs by using styles. More importantly, you can structure a 

document by apply- ing styles that are linked to 

outline levels. In doing so, you build a document 

outline that is reflected in the Navigation pane and 

can be used to create a table of contents. 

Styles can include character formatting (such 

as font, size, and color), paragraph formatting (such 

as line spacing and outline level), or a combination 

of both. Styles are stored in the template that is 

attached to a document. By default, blank new 

documents are based on the Normal template. The 

Normal template includes a standard selection of 

styles that fit the basic needs of most documents. 

These styles include nine heading levels, various 

text styles including those for multiple levels of 

bulleted and numbered lists, index and table of contents entry styles, and many 

specialized styles such as those for hyperlinks, 

quotations, placeholders, captions, and other 

elements. 

 

 
Figure 41- The Styles gallery in a new, blank 

document based on the Normal template. 
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By default, Word makes the most common predefined styles available in the 

Styles gallery on the Home tab. 
 

Styles can be used for multiple purposes: to affect the appearance of the content, 
to build a document outline, and to tag content as a certain type so that you can 
easily locate it. 

 

Figure 42- Heading styles define a document’s outline. 

  Styles stored in a template are usually based on the Normal style and use only 

the default body and heading fonts associated with the document’s theme, so they all 

go together well. For this reason, formatting document content by using styles 

produces a harmonious ef- fect. After you apply styles from the current style set, you 

can easily change the look of the entire document by switching to a different style set, 

which associates different formatting rules with the same styles. So if you have applied 

the Heading 1 style to a paragraph, you can change its formatting simply by changing 

the style set. 

 

Style sets are available from the Document Formatting menu on the Design tab. 
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Figure 43- Pointing to a style set in the gallery displays a live preview of the effects 

of applying that style set to the entire document. 

 
TIP Style sets provide a quick and easy way to change the look of an existing 

document. You can also modify style definitions by changing the template on which 

the document is based.  

5.2 Changing a document’s theme 

Every document you create is based on a 

template, and the look of the template is 

con- trolled by a theme. The theme is a 

combination of coordinated colors, fonts, 

and effects that visually convey a certain 

tone. To change the look of a document, 

you can apply a different theme by clicking 

the Themes button in the Document 

Formatting group on the Design tab, and 

then making a selection in the Themes 

galleryIf you like the background elements 

of one theme but not the colors or fonts, 

you can mix and match theme elements. 

First apply the theme that most closely 

resembles the look you want, and then 

select colors and fonts from the Theme 

Colors and Theme Fonts galleries in the 

Document Formatting group. 

3 
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In addition to colors and fonts, you can control more subtle elements such as 

paragraph spacing and visual effects that are associated with a theme. 

If you create a combination of theme elements that you would like to be able to 

use with other documents, you can save the combination as a new theme. By 

saving the theme in the default Document Themes folder, you make the theme 

available in the Themes gallery. However, you don’t have to store custom 

themes in the Document Themes folder; you can store them anywhere on your 

hard disk, on removable media, or in a network location. To use a theme that is 

stored in a different location, click Browse For Themes at the bottom of the 

Themes menu, locate the theme you want in the Choose Theme Or Themed 

Document dialog box, and then click Open to apply that theme to the current 

document. 

TIP The default Document Themes folder is stored within your user profile. On a 

default freestanding installation, the folder is located at C:\Users\<user 

name>\AppData\Roaming\ Microsoft\Templates\Document Themes. In a corporate 

environment with managed com- puter configurations, the user profile folder might 

be located elsewhere. To find the loca- tion of your Document Themes folder, click 

Save Current Theme at the bottom of the Themes menu and then in the Save Current 

Theme dialog box, click the icon at the left end of the address bar to display the full 

path to the Document Themes folder. 

 
By default, Word applies the Office theme to all new, blank documents. 

In Word 2013, the Office theme uses a primarily blue palette, the Calibri 

font for body text, and Calibri Light for headings. You can make a 

different theme the default by applying the theme you want and then 

clicking Set As Default in the Document Formatting group. 

 
TIP If multiple people create corporate documents for your company, you can ensure 

that everyone’s documents have a common look and feel by assembling a custom 
theme and making it available to everyone. Use theme elements that reflect your 

corporate colors, fonts, and visual style, and then save the theme to a central location 

or send the theme file by email and instruct your colleagues to save it to the default 

Document Themes folder. 

5.3 Manually changing the look of characters 

Word 2013 makes changing the look of content in a styled 
document almost effortless. But styles and themes can’t do everything. 
To be able to precisely control the look of your text, you need to know 
how to manually change individual elements. 

 
When you enter text in a document, it is displayed in a specific 

font. By default, the font used for text in a new blank document is 11-
point Calibri, but you can change the font of any element at any time. 
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The available fonts vary from one computer to another, depending on the 
programs installed. Common fonts include Arial, Verdana, and Times 
New Roman. 

 
You can vary the look of a font by changing the following attributes: 

 

▪ Size Almost every font comes in a range of sizes, which are 

measured in points from the top of letters that have parts that stick 

up (ascenders), such as h, to the bottom of letters that have parts 

that drop down (descenders), such as p. A point is approxi- mately 

1/72 of an inch (about 0.04 centimeters). 

▪ Style Almost every font has a range of font styles. The most 

common are regular (or plain), italic, bold, and bold italic. 

▪ Effects Fonts can be enhanced by applying effects, such as 

underlining, small capital letters (small caps), or shadows. 

▪ Color A palette of coordinated colors is available, and you can also 

specify custom colors. 

▪ Character spacing You can alter the spacing between characters 

by pushing them apart or squeezing them together. 
 

Although some attributes might cancel each other out, they are 
usually cumulative. For ex- ample, you might use a bold font style in 
various sizes and various shades of green to make words stand out in a 
newsletter. Collectively, the font and its attributes are called character 
formatting. 

 
You apply character formatting from one of three locations: 

 

▪ Mini Toolbar Several common formatting buttons are available on 

the Mini Toolbar that appears when you select text. 

                        

The Mini Toolbar appears temporarily when 

you select text, becomes transparent when 

you move the pointer away from the 

selected text, and then disappears entirely. 

 

▪ Font group on the Home tab- This group includes 

buttons for changing the font and most of the font attributes you are likely 

to use. 

 

▪ Font dialog box- Less-commonly applied attributes 

Figure 45 Mini toolbar for 
Formatting 
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such as small caps and special underlining are available from the Font 

dialog box, which you display by clicking the  

Font dialog box launcher. 
 

 
Figure 47 Most font attributes are set from the Font page of the dialog box, except 
character spacing and OpenType attributes, which are set on the Advanced page. 

 

In addition to applying character formatting to change the look of characters, 

you can apply predefined text effects to a selection to add more zing. Clicking 

the Text Effects And Typography button in the Font group on the Home tab 

displays a gallery of effects matched to the current 

theme colors. 

You can apply any predefined effect in the gallery to 
selected text, or you can click options below the gallery 
and define a custom effect. 

These effects are dramatic, so you’ll probably want to 
restrict their use to document titles and similar elements 
to which you want to draw particular attention. 

5.4 Manually changing the look of 
paragraphs 



80 

A paragraph is created by entering text and then pressing the Enter key. 
A paragraph can contain one word, one sentence, or multiple sentences. You can 
change the look of a para- graph by changing its indentation, alignment, and line 
spacing, as well as the space before and after it. You can also put borders around 
it and shade its background. Collectively, the settings you use to vary the look of a 
paragraph are called paragraph formatting. 

 
In Word, you don’t define the width of paragraphs and the length of 

pages by defining the area occupied by the text; instead you define the size of the 
white space—the left, right, top, and bottom margins—around the text. You click 
the Margins button in the Page Setup group on the Page Layout tab to define 
these margins, either for the whole document or for sections of the document. 

 
Although the left and right margins are set for a whole document or 

section, you can vary the position of the paragraphs between the margins. The 
quickest way to indent a paragraph from the left is to click the Increase Indent 
button; clicking the Decrease Indent button has the opposite effect. 

 

TIP   You cannot increase or decrease the indent beyond the margins by using the 

Increase Indent and Decrease Indent buttons. If you do need to extend an indent 

beyond the margins, you can do so by setting negative indentation 

measurements in the Paragraph dialog box. 

 

Another way to control the indentation of lines is by dragging markers on 
the horizontal ruler to indicate where each line of text starts and ends. You can 
set four individual indent markers for each paragraph: 

 First Line Indent The paragraph’s first line of text begins at this marker. 

 Hanging Indent The paragraph’s second and subsequent lines of text 

begin at this marker at the left end of the ruler. 

 Left Indent The left side of the paragraph aligns with this marker. 

 Right Indent The paragraph text wraps when it reaches this marker at 

the right end of the ruler. 
 

You display the horizontal and vertical rulers by selecting the Ruler check 
box in the Show group on the View tab. 

 

 
Figure 49 You can manually change a paragraph’s indentation by moving the 

indent markers on the horizontal ruler. 
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Setting a right indent indicates where the lines in a paragraph should end, 

but sometimes you might want to specify where only one line should end. For 

example, you might want to break a title after a specific word to make it look 

balanced on the page. You can end an individual line by inserting a text 

wrapping break (more commonly known as a line break). After positioning the 

cursor where you want the break to occur, click the Breaks button in the Page 

Setup group on the Page Layout tab, and then click Text Wrapping. Word indi- 

cates the line break with a bent arrow (visible when hidden formatting symbols 

are shown). Inserting a line break does not start a new paragraph, so when you 

apply paragraph for- matting to a line of text that ends with a line break, the 

formatting is applied to the entire paragraph, not only to that line. 

 
KEYBOARD SHORTCUT Press Shift+Enter to insert a line break. 

 

You can also determine the positioning of a paragraph between the left and 

right margins by changing its alignment. There are four paragraph alignment 

options: 

▪ Align Left Aligns each line of the paragraph at the left margin, with a 

ragged right edge 

KEYBOARD SHORTCUT Press Ctrl+L to left-align a paragraph. 

▪ Center Aligns the center of each line in the paragraph between the left 

and right margins, with ragged left and right edges 

KEYBOARD SHORTCUT Press Ctrl+E to center-align a paragraph. 

▪ Align Right Aligns each line of the paragraph at the right margin, with a 

ragged left edge 

KEYBOARD SHORTCUT Press Ctrl+R to right-align a paragraph. 

▪ Justify Aligns each line between the margins and modifies the spacing 

within  the line to create even left and right edges 

KEYBOARD SHORTCUT Press Ctrl+J to justify a paragraph. 
TIP If you know that you want to create a centered paragraph, you don’t 
have to type the text and then align the paragraph. You can use the Click 

And Type feature to create appro- priately aligned text. Move the pointer to 

the center of a blank area of the page, and when the pointer’s shape 

changes to an I-beam with centered text attached, double-click to insert the 

cursor in a centered paragraph. Similarly, you can double-click at the left 

edge of the page to enter left-aligned text and at the right edge to enter 

right-aligned text. 

You can align lines of text in different locations across the page 

by using tab stops. The eas- iest way to set tab stops is to use the 

horizontal ruler. By default, Word sets left-aligned tab stops every half 

inch (1.27 centimeters). To set a custom tab stop, start by clicking the 
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Tab button located at the left end of the ruler until the type of tab stop 

you want appears. 

 
Figure 50 The tab options. 

 
Figure 51 The ruler displays the custom tab stops for the selected paragraph. 

 
You have the following options: 

▪ Left Tab Aligns the left end of the text with the 

tab stop 

▪ Center Tab Aligns the center of the text with the 

tab stop 

▪ Right Tab Aligns the right end of the text with 

the tab stop 

▪ Decimal Tab Aligns the decimal point in the 

text (usually a numeric value) with the 
tab stop 

▪ Bar Tab Draws a vertical line at the position of 

the tab stop 

After selecting the type of tab stop you want to set, simply click the 

ruler where you want the tab stop to be. Word then removes any 

default tab stops to the left of the one you set. 

To change the position of an existing custom tab stop, drag 

it to the left or right on the ruler. To delete a custom tab stop, drag 

it away from the ruler. Or, if you find it too difficult to “grab” the tab 

stops on the ruler, you can set, clear, align, and format tab stops 

from the Tab dialog box, which you open by clicking the Tabs 

button at the bottom of the Paragraph dialog box. You might also 

work from this dialog box if you want to use tab leaders—visible 

marks such as dots or dashes connecting the text before the tab 

with the text after it. For example, tab leaders are useful in a table 

of contents to carry the eye from the text to the page number. 

Figure 52 You can specify the 
alignment and tab leader for each tab. 

 

ing 
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To align the text to the right of the cursor with the next 

tab stop, press the Tab key. The text is then aligned on the 

tab stop according to its type. For example, if you set a 

center tab stop, pressing Tab moves the text so that its 

center is aligned with the tab stop. 
 

To make it obvious where one paragraph ends and 

another begins, you can add space between them. There are 

several methods for adjusting paragraph spacing within a 

document: 

o To set the spacing for all paragraphs in a 

document, choose from the Paragraph Spacing options in the 

Document Formatting group on the Design tab. 
 

o To set the spacing for only selected 

paragraphs, adjust the Spacing Before and Spacing 

After settings in the Paragraph group on the Page 

Layout tab. 

o To make a quick adjustment to selected 

paragraphs, click the paragraph spacing 

commands on the Line And Paragraph Spacing menu 

that is available in the Paragraph group on the 

Home tab. 
 

When you want to make several adjustments to 

the alignment, indentation, and spacing of 

selected paragraphs, it is sometimes 

quicker to use the Paragraph dialog 

box than to click buttons and drag 

markers. Clicking the Paragraph 

dialog box launcher on either the Home tab 

or the Page Layout tab opens the 

Paragraph dialog box. 

 
 

You can do a lot with the options in 
the Paragraph dialog box, but to make a 
paragraph really stand out, you might want 
to put a border around it or shade its 
background. (For real drama, you can do 
both.) Clicking the Border arrow in the 
Paragraph group on the Home tab displays 

Figure 54 You can set internal line 
spacing or add or remove external 
space from this menu. 

 

Figure 55 The Indents And Spacing page of the Paragraph 

dialog box. 
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a menu of border options. You can select a predefined border from the Borders 
menu, or click Borders And Shading at the bottom of the menu to display the 
Borders And Shading dialog box, in which you can select the style, color, width, 
and location of the border. 

 
You can customize many aspects of the border. By clicking Options 

you can set the specific distance 

between the paragraph text and 

border. 
 

. 

5.5 Applying 
Borders and Shading 

To enhance the appearance of the 

text in a paragraph, you can 

quickly add a border and shading 

to selected text. When you add a 

border, you can specify what sides 

you want to include or exclude. 

For example, you can add a 

border on just the top and the 

bottom and leave the sides open. Shading colors the background behind the 

selected text or paragraph. If you 

want to customize borders and shading by 

changing line style, color, and width 

preferences, you can make changes in the 

Borders and Shading dialog box. 

5.5.1 Apply a Border 
  Select the paragraph text you 

want to format. 

  Click the Home tab. 

  Click the Borders and 

Shading button arrow, and then click 

Figure 57 Border Colour 
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to select the border commands to add or remove a border. 

 

5.5.2 Apply Paragraph Shading 
  Select the paragraph text you want to format. 

  Click the Home tab. 

  Click the Shading button arrow, and then click to select the shading 

color you want to apply to the selected text. 

 

5.5.3 Apply Paragraph Shading and Borders 

1.  Select the paragraph text you want to format. 

2.  Click the Home tab. 

3.  Click the Borders and Shading button arrow, and then click Borders and 

Shading. 

4.  Click the Borders tab.  

5.  Click to select the type of Setting you want for your border. 

6.  Click to select the type of 
Style. 

7.  Apply any other options you 
want. 

8.  Look in the preview box to 
see the new border. 

9.  Click the Shading tab. 

10.  Click to select the shading fill 
color you want to apply to 
your table. 

11.  Apply any other options you 
want. 

12.  Look in the preview box to 
see the new shading color. 

13.  Click OK. 
Figure 59 Border and Shading  Dialog 
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5.6 Creating and modifying lists 

Lists are paragraphs that start with a character and are formatted with a 

hanging indent so that the characters stand out on the left end of each 

list item. Fortunately, Word takes care of the formatting of lists for you. 

You simply indicate the type of list you want to create. When the order of 

items is not important—for example, for a list of people or supplies a 

bulleted list is the best choice.  And when the order is important—for 

example, for the steps in a procedure—you will probably want to create a 

numbered list. 

 

You can format an existing set of paragraphs as a list or create the list as 

you enter information into the document. 

To format a new list item as you enter content, start the paragraph as follows: 

 

▪ Bulleted list Enter * (an asterisk) at the beginning of a paragraph, and 

Figure 60 Shading  Dialog 
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3 

then press the Spacebar or the Tab key before entering the list item text. 

▪ Numbered list Enter 1. (the number 1 followed by a period) at the 

beginning of 
a paragraph, and then press the Spacebar or the Tab key before entering the 

list 
item text. 

 

When you start a list in this fashion, Word automatically formats it as a 

bulleted or num- bered list. When you press Enter to start a new item, Word 

continues the formatting to the new paragraph. Typing items and pressing Enter 

adds subsequent bulleted or numbered items. To end the list, press Enter twice; 

or click the Bullets arrow or Numbering arrow in the Paragraph group on the 

Home tab, and then in the library, click None. 

 

TIP If you want to start a paragraph with an asterisk or number but don’t 
want to format the paragraph as a bulleted or numbered list, click the 

AutoCorrect Options button that appears after Word changes the 

formatting, and then in the list, click the appropriate Undo option. You can 

also click the Undo button on the Quick Access Toolbar. 

 

If you want to create a list that has multiple levels, start off by creating the 

list in the usual way. Then when you want the next list item to be a level lower 

(indented more), press the Tab key at the beginning of that paragraph, before 

you enter the lower-level list item text. If you want the next list item to be a level 

higher (indented less), press Shift+Tab at the begin- ning 

of the paragraph. In the case of a bulleted list, Word 

changes the bullet character for each item level. In the 

case of a numbered list, Word changes the type of 

numbering used, based on a predefined numbering 

scheme. 

 

If you create a set of paragraphs containing a 

series of items and then decide you want to turn the 

set into a list, you can select the paragraphs and then click the Bullets, 

Numbering, or Multilevel List button in the Paragraph group on the Home tab.  

 

After you create a list, you can modify, format, and customize the list as 

follows: 

▪ You can move items around in a list, insert new items, or delete unwanted 

items. If the list is numbered, Word automatically updates the numbers. 

Figure 61 Bullets and umbering 
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▪ You can modify the indentation of the list by dragging the indent markers on 

the horizontal ruler. You can change both the overall indentation of the list 

and the rela- tionship of the first line to the other lines. 

5.6.1 Create a multilevel list 

A multilevel list shows the list items at different levels rather than at one 

level. 

 

You can pick a multilevel list style from the gallery, or you can create a 

new multilevel list style. 

5.6.2 Choose a multilevel list style from the 
gallery 

1. Click where you want to begin your list.  

2. On the Home tab, in the Paragraph group, click 

the arrow next to Multilevel List. 

3. Click a multilevel list style in the gallery of styles. 

4. Type your list. Press the TAB key or SHIFT+TAB 

to change levels. 

5.6.3 Create a new multilevel list style to add to 
the gallery 

If the multilevel list styles in the gallery aren't what you are looking for, you 

can create and define a new multilevel list style. You can use your new list style 

each time you begin a new multilevel list in a document. The new list style is 

added automatically to the gallery of list styles. 

1. On the Home tab, in the Paragraph group, click the arrow next 

to Multilevel List. 

Figure 62 Multilevel list 
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2. Click Define New Multilevel List. 

Beginning with level 1, enter your number format, font, and position 

choices. Continue to define each level that you want to use in your multilevel list. 

NOTE   When you define a multilevel list style, you can mix numbers and 

bullets in the same list. For example, in the Number style for this level box, you 

can scroll down and click a bullet style for a particular level. 

3. Click OK. 

The multilevel list style that you defined is automatically set as the current 

multilevel list style. 

NOTE   To move a multilevel item to a different numbering level, select the 

item, click the arrow next to Bullets orNumbering in the Paragraph group on 

the Home tab, point to Change List Level, and then click the list level to which 

you want to move the list item. 

5.6.4 Defining new styles 

What is the difference between the Define New Multilevel 

List and Define New List Style commands? The Define New Multilevel 

List command is convenient for creating and saving a list style that you won't 

ever change or that you will use in a single document. You can use the Define 

New List Style command to change the style design you created. If you use 

the Define New List Style command to define a new list style and then you 

make changes to the style, every instance of that list style is updated in the 

document. 

5.6.5 Advance the numbering manually in a list 

Certain numbered lists — for example, legal lists — require the ability to 

change a number manually and for Word to correctly change the numbers that 

follow. You can use the Set Numbering Value option to change a number 

manually while Word renumbers the list that follows. 

1. Right-click the number in the list that you want to change. 

2. Click Set Numbering Value and then do one of the following: 
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o Click Start new list and change the value of the selected 

number in the Set value to box. 

o Click Continue from previous list, select the Advance value 

(skip numbers) check box, and then change the value of the 

selected number in the Set value to box that corresponds to the 

level of the number that you selected. 

5.7 Controlling what appears on each page 

When a document includes more content than will fit between its top and 

bottom margins, Word creates a new page by inserting a soft page break 

(a page break that moves if the preceding content changes). If you want 

to break a page in a place other than where Word would normally break 

it, you can insert a manual page break in one of three ways: 

▪ Click Page Break in the Pages group on the Insert tab. 

▪ Click Breaks in the Page Setup group on the Page Layout tab, and then 

click Page. 

▪ Press Ctrl+Enter. 

TIP As you edit the content of a document, Word changes the location of 

the soft page breaks, but not of any manual page breaks that you insert. 

 

If a paragraph breaks so that most of it appears on one page but its 

last line appears at the top of the next page, the line is called a widow. If 

a paragraph breaks so that its first line ap- pears at the bottom of one 

page and the rest of the paragraph appears on the next page, the line is 

called an orphan. These single lines of text can make a document hard to 

read, so by default, Word specifies that a minimum of two lines should 

appear at the top and bot- tom of each page. As with so many other 

aspects of the program, however, you have con- trol over this setting. On 

the Line And Page Breaks page of the Paragraph dialog box, you can 

specify whether widows and orphans are controlled or permitted. You 

can also change the following options: 

▪ Keep with next This option controls whether Word will break a 

page between the paragraph and the following paragraph. 

▪ Keep lines together This option controls whether Word will break a 

page within the paragraph. 

▪ Page break before This option controls whether Word will break a 

page before the paragraph. 
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6 

 

TIP You can apply these options to individual paragraphs, or you can 

incorporate them into the styles you define for document elements such 

as headings. For information about styles, see “Creating custom styles 

and templates” in Chapter 16, “Work in Word more efficiently.” 
 

When you want to format part of a document differently from the rest, for 

example with page layout settings that are different from the surrounding 

text, you do so by inserting section breaks above and below it. A 

common example of this is when you need to print a wide table on a 

page with a Landscape orientation within a report that has a Portrait 

page orientation. 

 

TIP Formatting selected text in columns automatically inserts section breaks.  

 

You insert a section break by clicking Breaks in the Page Setup group on the 

Page Layout tab and then selecting from the following section types: 

▪ Next Page Starts the following section on the next page 

▪ Continuous Starts a new section without affecting page breaks 

▪ Even Page Starts the following section on the next even-numbered page 

▪ Odd Page Starts the following section on the next odd-numbered page 

When hidden formatting marks are displayed, a section break appears in Print 

Layout view as a double-dotted line from the preceding paragraph mark to the 

margin, with the words Section Break and the type of section break in the 

middle of the line. 

 

TIP To remove a page or section break, click at the left end of the break, or 

select the break, and then press the Delete key. 

5.8 Presenting information in columns 

By default, Microsoft Word 2013 displays text in one 

column that spans the width of the page between the left and 

right margins. You can specify that text be displayed in two, 

three, or more columns to create layouts like those used in 

newspapers and magazines. When you format text to flow in 

columns, the text fills the first column on each page and then 

moves to the top of the next column. When all the columns on 

one page are full, the text moves to the next page. You can 

manually indicate where you want the text within each column to 
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end. 

The Columns gallery in the Page Setup group on the 

Page Layout tab displays several standard options for 

dividing text into columns. You can choose one, two, or 

three columns of equal width or two columns of unequal 

width. If the standard options don’t suit your needs, you 

can specify the number and width of columns. The number of columns is 

limited by the width and margins of the page. Each column must be at 

least a half inch (or 0.27 centimeter) wide. No matter how you set up the 

columns initially, you can change the layout or column widths at any time. 

 

 
You can format an entire document or a section of a document in 

columns. When you select a section of text and format it in columns, 

Word inserts section breaks at the beginning and 

end of the selected text 

to delineate the area in 

which the columnar 

formatting is applied. 

Within the columnar 

text, you can insert 

column breaks to 

specify where you want 

to end one column and 

start another. Section 

breaks and column 

breaks are visible when 

you display hidden 

formatting marks in the 

document. 

4 

 

You apply character 

and paragraph 

formatting to 

columnar text in the same way 

you do to any other text. Here are some 

formatting tips for columnar text: 

 

Figure 64 The Columns 

gallery displays the 

predefined column 

options. 

 

Figure 65 More options….. of Column 
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▪ When presenting text in columns, you can justify the paragraphs to 

give the page a clean and organized 

appearance. 

  

▪ To more completely fill columns with text and lessen the amount of  

white space within a line, you can have Word hyphenate the text and 
break longer words into syllables. 
 

 
Figure 67- Hyphnation 

When hyphenating a document, you can specify whether you want to allow 
stacked hyphens at the ends of consecutive lines of a paragraph. 

Figure 66 Hyphenation Option in Page setup 
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CHAPTER-6 

Working with Table, Chart and Excel Spreadsheet 
in MSWord 

 
6.1 Presenting information in tables 

A table is a structure of vertical columns and horizontal rows. 

Each column and each row can be identified by a heading, although 

some tables have only column headings or only row headings. The box 

at the junction of each column and row is a cell in which you can store 

data (text or numeric information). 

6.1.1 Creating Table 
You can create tables in a Word document in the following 

ways: 

 

▪ To create a blank table of up to 10 columns and eight rows, click 

Table on the Insert tab. This displays the Insert Table gallery and menu. 

The gallery is a simple grid that represents columns and rows of 

cells. Pointing to a cell in the grid outlines the cells that would be 

included in a table created by clicking that cell and displays a live 

preview of the prospective table.  
 
 
Clicking a cell in the grid inserts an empty table the width of the text 

column. The table has the number of rows 

and columns you indicated in the grid, with 

all the rows one line high and all the 

columns of an equal width. 

▪ To create a more customized empty table, click Insert Table on 

the Insert Table menu. This displays the Insert Table dialog box, in 

which you can specify the num- ber of columns and rows and 

the width of the table and its columns. 

▪ To create a less clearly defined empty table, click Draw Table on 

the Insert Table menu. 
This displays a pencil with which you can draw cells directly in 
the Word document to 
create a table. The cells you draw connect by snapping to a grid, 
but you have some control over the size and spacing of the rows 
and columns. After drawing a base table, 
you can erase parts of it that you don’t want and adjust the 

Figure 68 The intended table 
dimensions (expressed as columns 
x rows) are shown in the gallery 
header. 

 

Figure 69 You can create a custom-
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table, column, and row size by using tools on the Layout tool tab for tables. 
 

TIP When drawing a table, you can display the rulers or gridlines to help guide you 

in placing the lines. 
 

 

 
 To present data that 

already exists in the 

document (either as 

regular text or as a 

tabbed list) as a table, 

select the data and 

then click Convert Text to 

Table on the Insert Table 

menu. (Conversely, you can convert the active table to regular text by 

clicking Convert to Text in the Data group on the Layout tool tab.) 

 To create a table by entering data in a Microsoft Excel worksheet, click 

Excel Spreadsheet on the Insert Table menu. Enter the data you want in the 

spreadsheet that appears in the document—you can use Excel features 

such as functions and formulas to create or manipulate the data. Format 

the data in Excel as you want it to appear in Word. Then click in the 

document outside the spreadsheet window to insert a table- like snapshot 

of the data. You can modify the data by double-clicking the table and 

editing the content of the spreadsheet that opens. 

 

Tables appear in the document as a set of cells, usually delineated by 

borders or gridlines. (In some Quick Tables, borders and gridlines are 

turned off.) Each cell contains an end-of- cell marker, and each row ends 

with an end-of-row marker. 

 

TROUBLESHOOTING Two separate elements in Word 2013 are named 

gridlines, and both can be used in association with tables. From the Show 

group on the View tab, you can display the document gridlines with which 

you can position content on the page. From the Table group on the 

Layout tool tab, you can display the table gridlines that define the cells of 

a table. 

 

When you point to a table, a move handle appears in its upper-left corner 

and a size handle in its lower-right corner. When the cursor is in a table, 

two Table Tools tabs—Design and Layout—appear on the ribbon. 

 

Figure 70 You can draw a table directly on the page. 
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Figure 71 A table has its own controls and tool tabs. 

 
TIP The end-of-cell markers and end-of-row markers are identical in appearance, and 

are visible only when you display formatting marks in the document. The move 

handle and size handle appear only in Print Layout view and Web Layout view. 

 
After you create a table in Word, you can enter data (such as text, 
numbers, or graphics) into the table cells. You can move and position the 
cursor by pressing the Tab key or the arrow keys, or by clicking in a table 
cell. Pressing the Tab key moves the cursor to the next cell; pressing 
Shift+Tab moves the cursor to the previous cell. Pressing Tab when the 
cur- sor is in the last cell of a row moves the cursor to the first cell of the 
next row. Pressing Tab 
when the cursor is in the last cell of the last row adds a new row to the 
table and moves the cursor to the first cell of that row. 

 
You can modify a table’s structure by changing the size of the table, 
changing the size of one or more columns or rows, or adding or removing 
rows, columns, or individual cells. 

 

TIP To change a table’s structure, you often need to select 

the entire table or a specific col- umn or row. The simplest 

way to select an entire table is to point to or click in the table 

so that the move handle appears, and then click the move 

handle. To select a specific element, position the cursor in the 

table, column, or row, click the Select button in the Table 

group on the Layout tool tab, and then click the table element 

you want. Alternatively, you can point to the top edge of a 

column or left edge of a row and, when the pointer changes to 

an arrow, click to select the column or row. 

 
The basic methods for manipulating a table or its 
contents are as follows: 

 
▪ Insert rows or columns A new feature in Word 2013 makes it easier than 

Figure 72 Inserting a row or column now takes only 
one click. 
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ever to insert a single row or column in an existing table. Simply point to 

the left edge of the  
table where you want to insert a row, or to the top of 

the table where you want to insert a column. A gray  insertion indicator 

labeled with a plus sign appears as you approach a possible insertion 

point (after any existing row or column). When the inser- tion indicator 

turns blue, click to insert the row or column where indicated. 
 
 

To insert one or more rows or columns, select the same number of 

existing rows or columns adjacent to the location where you want to insert 

them. On the Mini Toolbar that appears, click Insert and then click Insert 

Above, Insert Below, Insert Left, or Insert Right. If the Mini Toolbar doesn’t 
appear, on the Layout tool tab, in the Rows & Columns group, click the Insert 

Above, Insert Below, Insert Left, or Insert Right button. 

▪ Insert cells To insert one or more cells in a table, select the number of 

cells you want to insert adjacent to the location where you want to insert 

them, click the Rows & Columns dialog box launcher to open the Insert Cells 

dialog box, and 

then specify the direction to move adjacent cells to accommodate the new 

cells. 

▪ Delete table elements Select one or more rows, 

columns, or cells. On the Mini Tool- bar that appears, or in 

the Rows & Columns group, click Delete, and then click 

Delete Cells, Delete Columns, Delete Rows, or Delete Table. 

 

▪ Resize an entire table Point to the table, and then drag the size 

handle that appears in its lower-right corner. Hold down the Shift key 

while dragging the size handle to maintain the original aspect ratio of the table. 

▪ Resize a single column or row Drag the right border of a column to the left 

or right to manually set the width, or double-click the border to adjust it to the 

narrowest width that fits its content. Drag the bottom border of a row up or 

down to manually 

set the height, or use the commands in the Cell Size group on the Layout tool 

tab to manage column width and row height. 

▪ Move a table Point to the table, and then drag the move handle that 

appears in its upper-left corner to a new location, or use the Cut and Paste 

commands in the Clip- board group on the Home tab to move the table. 

Figure 73 Insertubg Cells 
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▪ Merge cells Create 

cells that span multiple 

columns or rows by 

selecting the cells you 

want to merge and 

clicking the Merge Cells 

button in the Merge 

group on theLayout tool 

tab. For example, to 

center a title in the first 

row of a table, you can 

merge all the cells in the 

row to create one merged cell that spans the table’s width. 

▪ Split cells Divide one cell into multiple cells by clicking the Split Cells button 

in the Merge group on the Layout tool tab and then specifying the number of 

columns and rows into which you want to divide the cell. 

▪ Sort information Click the Sort button in the Data group on the Layout tool 

tab to sort the rows in ascending or descending order by the data in any 

column. For ex- ample, in a table that has the column headings Name, 

Address, ZIP Code, and Phone Number, you can sort on any one of those 

columns to arrange the information in 
alphabetical or numerical order. 

 

6.2 Performing calculations in tables 
When you want to perform calculations with the numbers in a Word table, 

you can create a formula that uses a built-in mathematical function. You 

construct a for- mula by using the tools in the Formula dialog box, which you 

display by clicking the Formula button in the Data group on the Layout tool tab. 

 

A formula consists of an equal sign (=), followed by a function name (such 

as SUM), followed by parentheses containing the location of the cells you want 

to use for the calculation. For example, the formula =SUM(Left) totals the cells 

to the left of the cell containing the formula. 

 

To use a function other than SUM in the Formula dialog box, you click the 

function you want in the Paste Function list. You can use built-in functions to 

perform a num- ber of calculations, including averaging (AVERAGE) a set of 

values, counting (COUNT) the number of values in a column or row, or finding 

the maximum (MAX) or minimum (MIN) value in a series of cells. 

 

Figure 74  Insert or delete table elements from the mini toolbar 
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Although formulas commonly refer to the cells above or to the left of the 

active cell, 

you can also use the contents of specified cells or constant values in formulas. 

To 

use the contents of a cell, you enter the cell address in the parentheses 

following the function name. The cell address is a combination of the column 

letter and the row number—for example, A1 is the cell at the intersection of 

the first column and the first row. A series of cells in a row can be addressed 

as a range consisting of the first cell and the last cell separated by a colon, 

such as A1:D1. For example, the formula =SUM(A1:D1) totals the values in 

row 1 of columns A through D. A series of cells in a column can be addressed 

in the same way. For example, the formula =SUM(A1:A4) totals the values in 

column A of rows 1 through 4. 

 

6.3 Other table layout options 
You can control many aspects of a table in the Table Properties dialog box, 
which you display by clicking the Properties button in the Table group on the 
Layout tool tab. You can set the following options: 

 
▪ On the Table page, you can specify the width of the table and the way it 

interacts with the surrounding text. From this page, you can also access 
border and shading options, including the internal margins of table cells. 

▪ On the Row page, you can specify the height of the selected rows, whether 

rows can break across pages (in the event that the table is wider than the 
page), and whether the header row is repeated at the top of each page 
when a table is longer than one page. 

 
TIP The Repeat As Header Row option applies to the entire table rather than 

the selected row. The option is available only when the cursor is in the top 

row of the table. Selecting this option helps readers of a document to more 

easily interpret data in multi-page tables. It also allows assistive devices 

such as screen readers to correctly interpret the table contents. 

o On the Column page, you can set the width of each column. 

o On the Cell page, you can set the width of selected cells and the vertical 
Alignment of text within them. Click the Options button on this page to set 
the internal margins and text wrapping of individual cells. 

o On the Alt Text page, you can enter text that describes what the table is 
about. Alt text may be displayed when a table can’t be displayed on the 
page, or when the document is read aloud by an assistive device to a 
person who has a visual impairment. Including alt text or a table caption 
improves the accessibility of the table. 

 

TIP You can also control cell width, alignment, and margins by using the settings in 

the Cell Size and Alignment groups on the Layout tool tab. 
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6.4 Formatting tables 

Manually formatting a table to best convey its data can be a process of 

trial and error. With Word 2013, you can quickly get started by applying 

one of the table styles available in the Table Styles gallery on the Design 

tool tab. The table styles include a variety of borders, col- ors, and other 

attributes that give the table a very professional appearance. 

 

 

Figure 75 Auto Formatting Table 

                  

 

 

 

In Word 2013, the Table Styles gallery is divided into sections for plain tables, grid tables, 

and list tables. 
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If you want to control the appearance of a table more precisely, you can use the 
commands on the Design and Layout tool tabs to format the table elements. You 
can also separately format the table content. As you saw in the previous exercise, 
you can apply character for- matting to the text in tables just as you would to 
regular text, by clicking buttons on the Mini Toolbar and in the Font, Paragraph, or 
Quick Styles groups on the Home tab. 
 

6.5 Quick Tables 
In addition to 
inserting empty 
tables, you can 
insert any of the 
available Quick 
Tables, which 
are predefined 
tables of 
formatted data 
that you can 
replace with your 

own in- 
formation. Built-in 
Quick Tables 
include a variety of calendars and 
simple tables. 

 

To create a Quick Table: 

 
1 On the Insert tab, in the Tables 

group, click the Table button, and 
then click Quick Tables to expand 
the Quick Tables gallery. 

2 Scroll through the gallery, 

noticing the types of tables that 

are available, and then click the 

one you want. 

3 Modify content and apply 

formatting to tailor the Quick 

Table to your needs. 

4  
 

 
 
 
 
 

Figure 77 The Quick Tables gallery includes a selection of predefined tables such as 
this one. 

Figure 76 The predefined Quick Tables can be a convenient 
starting point. 
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Figure 79 You can easily customize a Quick Table. 

 

You can also save a modified Quick Table, or any customized table, to the Quick Tables 
gallery. Saving a table saves both the table structure and the table content to the gal- 
lery. You can then easily insert an identical table into any document. 

 

To save a table to the Quick Tables gallery: 

1. Select the table by using the table selector or the commands in the Table group on the 
Layout tool tab. 

2. On the Insert tab, in the Tables group, click the Table button, click Quick Tables, and then 

click Save Selection to Quick Tables Gallery. 

3. In the Create new Building Block dialog box, assign a name to the table, and then click 

OK. 

When you exit Word, save the Building Blocks template when Word prompts you to do 
so, to ensure that the table will be available in the Quick Tables gallery for future use. 
To save a table to the Quick Tables gallery: 

1    Select the table by using the table selector or the commands in the Table group on the 
Layout tool tab. 

2 On the Insert tab, in the Tables group, click the Table button, click Quick Tables, and then 

click Save Selection to Quick Tables Gallery. 

3 In the Create new Building Block dialog box, assign a name to the table, and then click 

OK. 
When you exit Word, save the Building Blocks template when Word prompts you to do 
so, to ensure that the table will be available in the Quick Tables gallery for future use. 

In addition to inserting empty tables, you can insert any of the available Quick Tables, 
which are predefined tables of formatted data that you can replace with your own in- 
formation. Built-in Quick Tables include a variety of calendars and simple tables. 

Figure 78 Simple Text in Table 
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6.6 Inserting charts 

When  you create a new chart from within a Word 
document, Word and Excel work together to 
provide some pretty fancy functionality. A generic 
chart appears in the document, and a worksheet 
containing the sample data opens in Excel. You 
can then edit the sample data to create the chart 
that you want. You don’t have to save the Excel file; 
Word maintains its data with the document and it is 
available to you whenever you want to update it. 

 

 
Figure 81 A sample chart plotted from the data in its associated Excel worksheet 

TIP You can open the worksheet associated with a chart by clicking the chart and then 

clicking the Edit Data button in the Data group on the Design tool tab. 

 
The Excel worksheet is composed of rows and columns of cells that contain 
values, which in charting terminology are called data points. Collectively, a set of 
data points is called a data series. As with Word tables, each worksheet cell is 

Figure 80 Chart option from Illustration 
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identified by an address consisting of its column letter and row number—for 
example, A2 is the first cell in the second row. A range of cells is identified by the 
address of the cell in the upper-left corner and the address of the cell in the 
lower-right corner, separated by a colon—for example, A2:D5 is the range of 
cells from the first cell in the second row to the fourth cell in the fifth row. 

 
To customize the chart, you replace the sample data in the Excel worksheet with your 
own data. Because the Excel worksheet is linked to the chart, when you change the 
values in the worksheet, the chart changes as well. To enter a value in a cell, you click 
the cell to select it, or move to the cell by pressing the Tab key or arrow keys, and then 
enter the data. You can select an entire column by clicking the column header—the 
shaded box containing a letter at the top of each column—and an entire row by clicking 
the row header—the shaded box containing a number to the left of each row. You can 
select the entire worksheet by clicking the Select All button—the box at the junction of 
the column and row headers. 
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CHAPTER-7 

Sharing Document on OneDrive 

 

7.1 What is OneDrive?  
OneDrive is free online storage that comes with 

your Microsoft account. It’s like an extra hard drive 
that’s available from any of the devices you use. You 
no longer need to email files to yourself or carry 

around (and possibly lose) a USB flash drive. Instead, 

whether you’re on your laptop and working on a 
presentation, viewing photos from your last family 

vacation on your new tablet, or on your phone 

reviewing your shopping list, you can get to your files 

in OneDrive 

OneDrive is online file storage you can get to from 

anywhere. And it’s free. You get 15 GB of free storage 

with your Microsoft account, so you can store all types 

of files in one place and get to them from any device. 

You can easily share your OneDrive files, 

including photos and videos, with friends and family. 

And OneDrive works with Windows and Office, so it’s 
simple to work with OneDrive files on your computer and 

collaborate with other people on documents. 

7.2 Add files from your computer  
To add files to OneDrive, just drag them into your 

computer’s OneDrive folder using File Explorer or 

Finder. The files will automatically sync across all of your 

devices that have OneDrive installed. So you can drag a 

photo from your laptop to your OneDrive—and later open 

it in OneDrive on your phone. 

7.3 Add files from your phone or tablet  
To add photos and videos on your phone or tablet to 

OneDrive, use the OneDrive app. Even better—you can 

Figure 82 One drive in Explorer 

Kommentar [A1]:  
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also choose to turn on camera backup to automatically save the photos and videos 

you take to OneDrive. So even if you lose your phone or tablet, you won’t lose your 
memories! 

7.4 Add files using the OneDrive website 
You can also add files from any computer, tablet, or phone by using the 

OneDrive website. Just go to OneDrive.com, sign in, and then tap or click Upload. 

7.5 Share files 
You can share individual files and even entire folders without attaching anything. 

Send an email with a link to what you’d like to share—
and rest assured that everything else in your OneDrive 

will stay private. To share items from the OneDrive 

website, just select the check box in the upper-right 

corner of the item and choose Share. 

  7.6 Collaborate with Office 
OneDrive works with Office, so it's easy to 

collaborate. Instead of sending around different copies of 

documents, you can give other people permission to edit the 

document directly. You can even collaborate with people who 

don’t have Office installed on their computers—they can open 

and edit documents in OneDrive using Office Online. 

 

Figure 86 Saving in MSOffice 

Figure 84 Share file in One Drive 
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7.7 Getting to your files from 

anywhere 

When your files are in OneDrive, you can get to 

them from any device, even if something happens to 

your PC. You can go to theOneDrive website, or you 

can use one of the mobile apps for Android, iOS, or 

Windows Phone. 

 

 

 

7.8 Getting to files when you’re offline 

 

Figure 89 Getting files from OneDrive Offline 

Figure 88 Getting files from OneDrive Online 

Figure 87 Sharing in MsOffice 

http://go.microsoft.com/fwlink/p/?LinkID=251869
http://go.microsoft.com/fwlink/p/?LinkId=390052
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In Windows 8.1 and Windows RT 8.1, you can browse all your files 

in OneDrive even when you're not connected to the Internet. If you also want to open 

and edit files when you don't have an Internet connection, you need to make those files 

available offline. You can use the OneDrive app or File Explorer to make files available 

offline. 

7.9 To make files available offline using the OneDrive 

app 

Swipe down or right-click the file or folder to select it, and then tap or 

click Make offline. If you're worried about using too much space on your PC, make 

fewer files available offline, or if there are files you don’t need to use when you’re 
offline anymore, change them back to online-only. 

If space on your PC isn't a concern, you can also make your 

entire OneDrive available offline: 

Swipe in from the right edge of the screen, and then tap Settings. 

(If you're using a mouse, point to the lower-right corner of the screen, move the 

mouse pointer up, and then click Settings.) 

 Tap or click Options, and then turn on Access all files offline. 

7.10 To make files available offline using File Explorer 

Press and hold or right-click the file, and then choose Make available offline. To 

make your entire OneDrive available offline, press and hold or right-click OneDrive in the 

left pane, and then choose Make available offline. 
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CHAPTER-8 

Mailing Letter with Mail Merge 

8.1 Mail merge 

Many organizations communicate with their customers or members by means of 
letters, newsletters, and promotional pieces that are sent to everyone on a mailing list. 
The easiest way to generate a set of documents that are identical except for certain 
information—such as the name, address, and greeting of a letter—is to use a process 
called mail merge. If you have a list of potential recipients stored in a consistent format, 
you can use the mail merge process to easily produce a set of documents, email 
messages, or mailing labels. 

 
The mail merge process combines static information stored in one document 

with variable information stored in another document, as follows: 
 
▪ Main document This document contains the static text that will appear in all 

the merged documents. It also contains placeholders—called merge fields—that display 
the variable information. 

▪ Data source This is a structured document, such as a Microsoft Word table, 

Excel worksheet, Access database table, or Outlook contact list, that contains sets of 
information—called records—in a predictable format. You can use an existing data 
source,or you can create a new one as part of the mail merge process. 

8.2 Preparing data sources 
The first step in the mail merge process is to either specify an existing data source or 
create one. The data source consists of a matrix of rows and columns. Each row 
contains one record, such as the complete name and address of a customer, and each 
column contains a particular type of information—called a field—such as the first name 
of all the customers. In the first row of the data source, each field is identified by its 
column heading—called a field name. 

 
 
 
 
 

Figure 90 The data source stores information in a structured way. 



110 

TIP Because the field names are also used as the merge fields in the main document, they 

cannot contain spaces. To make the field names readable with no spaces, capitalize each word, as in 

PostalCode, or replace the spaces with underscores, as in Last_Name. 

If the data source contains many records and it changes frequently, you might 
want to create it in a program designed for working with large amounts of data, such as 
Excel or Access. You can also use the contacts list from Outlook. If the data source 
contains only a few records and it won’t be updated often, you can create it in Word, 
either as a table or as a list with each field separated by a tab. Or you can create it as 
part of the mail merge process. 

 
What if you want to create merge documents for only a subset of the data in the 

data source? For example, you might have mail-order customers from all over the United 
States but want to send an announcement about a store sale only to customers with 
addresses in your state. After you specify the data source, you can do the following: 

 Filter the data source to create merged documents for only some of its 

data. 

 Create a query (a set of selection criteria) to extract only the information 

you’re interested in—for example, all the postal codes for your state. 

 Sort the data source—for example, in postal code order for a bulk 

mailing. 
 
When you use a filter or a query, all the data remains in the data source, but only 

the data that meets your specifications is used for the mail merge. 
 

1 On the Mailings tab, in the Start Mail Merge group, click the Start Mail Merge 
button, and then click Step-by-Step Mail Merge Wizard to open the Mail Merge pane. 

 

2 With 
Letters selected 
as the document 
type, at the 
bottom of the Mail 
Merge pane, click 
Next: Starting 
document. 
Step 2 of the 
wizard requires 
you to select a 
starting 
document. We 
will use the 
currently active 
document. 

3 With 
Use the 
current 

ps. 
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document selected in the Step 2 pane, click Next: Select recipients. 

Step 3 of the wizard requires you to select a data source. We will use the CustomerList 
workbook. 

4. With Use an existing list selected in the Step 3 pane, click Browse to open the 

Select Data Source dialog box. 

5. Navigate to the folder, and double-click the CustomerList workbook to open 
the Select Table dialog box. Notice that the workbook contains only one 
table. 

 
 
6     With Customers$ selected 
in the Select Table dialog box, 
click OK to open the Mail 
Merge Recipients dialog box. 
 
 
       . 

 
 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 
Figure 93 The dialog box displays all the records contained in the data source

Figure 92 If a workbook contains multiple tables, you must select the one 
that contains the mail merge 
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7     In the Data Source box, click CustomerList .xlsx, and then click Edit to open the Edit 
Data  Source dialog box. 
 

 
Figure 94 You can modify the source data before performing the mail merge operation. 

8     Click the New Entry button, and then enter the following information, pressing Tab 
to move from field to field: 

FirstName         Max  

LastName           Stevens  

Address1            678 Pine St . 

City                    Agriculture  

State                 WA  

PostalCode        10003 

TIP You can add multiple records by clicking New Entry after you enter each record. 

 
9 Click OK, and then click Yes to update the recipient list. Notice that the new 
record appears below the original records in the Mail Merge Recipients dialog box. 

Now we’ll modify the order in which the mail merge process accesses the data source records. 

10     In the Refine recipient list area, click Sort to display the Sort Records page of the 
Filter and Sort dialog box. 

11     Click the Sort by arrow to display the sort criteria, which are the same as the field 
names in the selected data source. 
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Figure 95 You can sort the records by up to three fields, each in ascending or descending order. 

 
12 Scroll to the bottom of the Sort by list, and click PostalCode. Then with Ascending 
selected, click OK to return to the Mail Merge Recipients dialog box, which now displays the 
recipients in order by postal code. 
 
TIP You can also sort data in the Mail Merge Recipients dialog box by clicking the arrow to the right of the field 

you want to sort on and then clicking Sort Ascending or Sort Descending. 
 
13 Scroll to the right end of the recipients list, and verify that the records are sorted in 
ascending order by the PostalCode field. Then in the Refine recipient list area, click Filter to 
display the Filter Records page of the Filter and Sort dialog box. 

TIP You can also open the Filter And Sort dialog box by clicking the arrow to the right of any field name and 
then clicking Advanced. 

In the Field list, click State to display the default Equal To criterion in the Comparison 
box. In the Compare to box, enter WA (the postal abbreviation for Washington). 
 

 
Figure 96 You can choose to merge only records that match specific criteria. 
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15     In the Filter and Sort dialog box, click OK to filter the source data to use only 
residents of the state of Washington in ascending PostalCode order. 
 

 
Figure 97 The records for customers who do not live in Washington are hidden and 
 will be excluded from the merge process. 

16     Click OK to close the Mail Merge Recipients dialog box and complete step 3 of the 
Mail Merge wizard 

8.3 Using an Outlook contacts list as a data source  
Using information from an Outlook contacts list as the data source for the merge process 

requires a few extra steps in the Mail Merge wizard. 
 

To use Outlook information as the data source for a form letter: 

 
1    In step 3 of the Mail Merge wizard, in the Select Recipients area, click Select from 

Outlook contacts, and then click Choose Contacts Folder. 

2    If you are prompted to select an Outlook profile, click the one you want to use, 
and then click OK to open the Select Contacts dialog box. 

3 In the Select a Contact Folder to Import list, click the folder you want to use, and then 

click OK to open the Mail Merge Recipients dialog box and display your Outlook 

contacts. 

4 In the contacts table, clear the check boxes of any contacts you want to exclude 
from the merge process, or sort and filter the list to display the contacts you want 
to include in the desired order. 

5    Click OK. 

8.4 Preparing main documents 
One type of main document commonly used in the mail merge process is a form letter. 
This type of document typically contains merge fields for the name and address of 
each recipi- ent along with text that is the same in all the letters. In the form letter, each 
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merge field is enclosed in « and » characters, which are called chevrons—for 
example, «AddressBlock». 
 
If you have already written the letter, you can insert the merge fields during the merge 
process; if you haven’t written the letter, you can write it as part of the process. Either 
way, you first enter the text that will be common to all the letters and then insert the 
merge fields that will be replaced by the variable information from the data source. 
 
TIP If you need to stop before you finish the merge process, you can save the form letter to 

retain the work you have done so far. You can then open the form letter and resume from  
   

where you left off. Because you have specified a data source for the form letter, you will be 

asked to confirm that you want to reattach the same data source. 

You can insert merge fields in two ways: 
 

▪ From the Mail Merge pane in step 4 of the Mail Merge wizard 

▪ By clicking buttons in the Write & Insert Fields group on the Mailings tab 
 

Either way, clicking Address Block or Greeting Line opens a dialog box in which you 
can refine the fields’ settings, whereas clicking individual fields inserts them with their 
default settings. 

 

  
You can insert a merge field anywhere in the main document. 

 
TIP To save the form letter without any mail merge information, click Start Mail Merge in the Start 

Mail Merge group on the Mailings tab, and then click Normal Word Document. 

You can insert merge fields in two ways: 
 

▪ From the Mail Merge pane in step 4 of the Mail Merge wizard 

▪ By clicking buttons in the Write & Insert Fields group on the Mailings tab 
 

Either way, clicking Address Block or Greeting Line opens a dialog box in which you can 

refine the fields’ settings, whereas clicking individual fields inserts them with their 

default settings. 

 
 

You can insert a merge field anywhere in the main document. 

 
TIP To save the form letter without any mail merge information, click Start Mail Merge in the Start 

Mail Merge group on the Mailings tab, and then click Normal Word Document. 

 

8.5 Merging main documents and data sources  
After you specify the data source you want to use and enter merge fields in the main 
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document, you can preview the merged documents and then perform the actual 

merge. You can further filter the source data during the preview process. When you’re 

ready, you can either send the merged documents directly to the printer or you can 

merge them into a new document. If you merge to a new document, you have another 

chance to review and, if necessary, edit the merged documents before sending them 

to the printer. 
 
 

1       In the Mail Merge pane, click Next until the Step 5 pane is displayed. 

2 Hide formatting marks and, if necessary, adjust the view until the address 
block, greeting line, and third paragraph are all displayed at the same time. Word 
displays a preview of how the personalized letter will look when merged with the 
data source. 

 
                           Figure 98 You can preview how the personalized letters will look before you proceed 

with the merge. 

 
 

3     In the Preview your letters area of the Mail Merge pane, click the Previous Record 
button three times to preview all the letters. 

 
TIP You can also preview the next or previous documents by clicking the Next Rec- ord or 
Previous Record button in the Preview Results group on the Mailings tab. You can jump to 

the first merged document by clicking the First Record button or to the last merged 

document by clicking the Last Record button. 

4 To exclude the displayed recipient (Garth Fort) from the merge, click the Exclude 
this recipient button in the Make changes area of the Mail Merge pane. 

Now we’ll tidy up the address block by modifying the paragraph formatting of the 
merge field. 
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5 In the document, drag to select all three lines of the address block. Then on the Home 
tab, in the Paragraph group, click the Line and Paragraph Spacing button, and click Remove 
Space After Paragraph to move the address lines together. 

6 Click away from the selection and preview the letters again. Then at the bottom of the 
Mail Merge pane, click Next: Complete the merge. 

7     In the Merge area of the Mail Merge pane, click Edit individual letters to open the 
Merge to New Document dialog box. 

 
8 With the All option selected, click OK to create a 

document named Letters1 that contains a personalized 
copy of the form letter for each of the selected 
records. 

9 If necessary, click the Print Layout button on the View 
Shortcuts toolbar to display the letters as individual 
pages. 

10       On the Quick Access Toolbar, click the Save button to 
open the Save As dialog box so that you can save the 
new document with a more specific name. 

 
11 Navigate to the Chapter14 practice file folder, enter My Merged Letters in the File name 

box, and then click Save to save the new document in the specified folder. 
 

8.6 Printing envelopes 
You can print an envelope based 
on an address in a document. To 
do so, follow these steps: 

1 In the document, select the 
lines of the address. (Do 
not select any blank lines 
above or below the 
address.) 

2    On the Mailings tab, in the 
Create group, click the Envelopes 
button to open the 

Envelopes and Labels dialog 
box. 

 

3 Size 10 is the default 

envelope size. If you want 

to select a different 

envelope size, click Options, 

make your selection, and then 

click OK. 

 
TIP You can save time by storing the return address with your user information. In the General area of the 

Figure 100 You can edit the delivery address and enter a return 
address. 

 

Figure 99 You can choose to merge 
only 
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14 

Advanced page of the Word Options dialog box, enter the return address in the Mailing Address box, and click 

OK. The address then appears by default as the return address in the Envelopes And Labels dialog box. If you 

want to use envelopes with a preprinted return address, you must select the Omit check box to avoid 

duplication. 

 

In the Envelope Options dialog box, you can also specify the feed method (hori- zontally or 
vertically and face up or face down), and the font and font size of both the address and the 
return address. 
 

If you have electronic postage software installed on your computer, you can include electronic 
postage. 
 

4    Insert an envelope in the printer, and then click Print. 
 

Alternatively, you can click Add To Document to have Word insert the address in the format 

required for an envelope on a separate page at the beginning of the current document. 

8.7 Sending personalized email messages to multiple 

recipients 
 

When you want to send the same information to all the people on a list—for example, 
all your customers, or all the members of a club or your family—you don’t have to print 
letters and physically mail them. Instead, you can use mail merge to create a 
personalized email message for each person in a data source. As with a form letter 
that will be printed, you can either use the Mail Merge wizard or use the buttons on the 
Mailings tab to insert merge fields into the form message. These merge fields will be 
replaced with information from the specified data source. 

 
If you are using the wizard, be sure to click E-mail Messages in step 1. If you are not 
using the wizard, you can specify the list of email addresses you want to send the 
message to by clicking the Select Recipients button in the Start Mail Merge group on 
the Mailings tab. In either case, you have three options: 

▪ Create an entirely new list of recipients by entering their contact information. 

▪ Use an existing list of recipients stored outside of Outlook. 

▪ Select recipients from an Outlook contacts list. 
 

You can quickly add merge fields to a form message by using the buttons in the Write & 
Insert Fields group. Many email messages need only a greeting line. Because email       
messages tend to be less formal than printed letters, you might want to start the 
messages with a custom greeting rather than one of the predefined greeting options 
(Dear and To). 

 
1 On the Mailings tab, in the Start Mail Merge group, click the Select Recipients button, 

and then in the list, click Type a New List to open the New Address List dialog box. 
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2 Click to position the cursor 

in the First Name field. Enter 
Andrea, press the Tab key, 
enter Dunker in the Last Name 
field, and press Tab until you 
reach the E-mail Address field 
(the last field in the table). 
Then enter andrea@ 
consolidatedmessenger .com. 

3     Click New Entry, and then add 
Judy Lew, with the email address 

judy@lucernepublishing .com. 
TIP If you have several email 
addresses to add to the list, you 

can press Tab in the 

last field of the last entry, 
instead of clicking New Entry 
each time. 

 

4 Repeat step 3 to add Ben Miller, with the email address ben@wingtiptoys .com, and then 
click OK to open the Save Address List dialog box, which is very similar to the Save As 
dialog box. 

5 Navigate to the Chapter14 practice file folder, enter My Email Data Source in the File name box, 
and then click Save to save the data source in the specified location as a database. 

Now we’ll insert the merge field in the main document. 

6 Position the cursor at the beginning of the ThankYouEmail document. On the Mailings tab, in 
the Write & Insert Fields group, click the Greeting Line button to open the Insert Greeting Line 
dialog box. 

7 In the first box in the Greeting line format area, drag to select Dear and then enter Hello 
followed by a comma and a space. In the second list, click Joshua. In the third list, click : 
(the colon). 

8 In the Preview area, click the Next button twice to preview the greetings as they will 
appear in the email messages. 

9 Click the First button to return to the first record, and then click OK to insert the 
«GreetingLine» merge field at the top of the form message. 

 

Figure 101 You can create a data source as part of the mail 
merge process. 

mailto:ben@wingtiptoys
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Figure 102 If you want to edit the custom greeting, right-click the merge field and then click Edit 

 
10 On the Mailings tab, in the Preview Results group, click the Preview Results button to 

display a preview of the first message. Click the Next Record button twice to 
preview the messages for other recipients. Then click the Preview Results button 
again to turn off the preview. 

11 In the Write & Insert Fields group, click the Highlight Merge Fields button to identify the 
merge fields in the document with a gray highlight. There is only one merge field 
in this document. 

Finally, we’ll merge the data source and main document directly to email 
messages. 

12     In the Finish group, click the Finish & Merge 
button, and then in the list, click Send 

Email Messages to open the Merge to E-mail 

dialog box. 
 

13 In the Message options area, verify that 
Email_Address is selected in the To list, enter 
Welcome to Wide World Importers! in the Subject 
line box, and verify that HTML is selected in 
the Mail format list. 

14 Click OK in the dialog box to send the email 
messages, or click Cancel to not send them. 

 

TIP Your email program might require that you log 

in or manually send the messages. If you are using 

Outlook, a copy of each sent message appears in your 

Outlook Sent Items folder. If you plan to send a large 

number of messages, you might want to turn off the 

saving of sent messages. 

Figure 103 You set up the email message 
header information and format in this dialog 
box. 
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8.8 Creating and printing labels 

Most organizations keep information about their customers or clients in a worksheet or 

database that can be used for several purposes. For example, the address information 

might be used to send billing statements, form letters, and brochures. It might also be 

used to 

print sheets of mailing labels that can be attached to items such as packages and 

catalogs. 
 

To create sheets of mailing labels, you first prepare the data source and then prepare 

the main document by selecting the brand and style of labels you plan to use. Word 

creates a table with cells the size of the labels on a page the size of the label sheet, so 

that each rec- ord will print on one label on the sheet. You insert merge fields into the 

first cell as a tem- plate for all the other cells. When you merge the main document 

and the data source, you can print the labels or create a new label document that you 

can use whenever you want to send something to the same set of recipients. 
 

1     On the Mailings tab, in the Start Mail Merge group, click the Start Mail Merge 

button, and then click Step-by-Step Mail Merge Wizard. 

2     In the Mail Merge pane, click Labels, and then click Next: Starting document. 

Figure 104  If you send the messages, you can locate them in your Sent Items folder. 
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3 With Change document layout selected in the Step 2 pane, click Label options 

to open the Label Options dialog box. 
 

 
Figure 105 Every label is different. You need to specify the print method, 

the manufacturer and/or type, and the product number so that Word can set up the labels correctly. 
 

4     In the Label information area, ensure that the Label vendors setting is 

Microsoft. 

TIP When you create and print labels, purchase the label blanks that fit your size 
requirements, and then select the vendor and product number of those labels in the Label 
Information area. If the label vendor and product number you need aren’t already available in 
the lists, click the Find Updates On Office.com link to download other available label 
configurations. 

 

5 In the Product number box, select the second 30 Per Page setting, which has 

labels with a Height of 1” and a Width of 2 .63”. Then click OK to insert a table 

that fills the first page of the main document. 

TROUBLESHOOTING The results are visible only when formatting marks are displayed. 

6     At the bottom of the Mail 

Merge pane, click Next: Select 

recipients. 

7 With Use an existing list 

selected, click Browse, 

navigate to the Chapter14 

practice file folder, double-
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click the CustomerList workbook, and then in the Select Table dialog box, click OK. 

8     In the Mail Merge Recipients dialog box, click OK to insert a «Next Record» merge field 

in all the cells in the main document other than the first cell. 

9 At the bottom of the Mail Merge pane, click Next: Arrange your labels, and then 

ensure that the left edge of the main document is visible. 

10     With the cursor positioned in 
the first cell, click Address block in the 
Merge your labels area of the Mail 
Merge pane. 

11 In the Insert Address Block dialog box, click OK to accept the default settings to insert 

an «AddressBlock» merge field into the first cell. 
 

 

 
 
 
 
 
 
 

 

 

. 
 

 
 

12 In the Replicate labels area of the Mail Merge pane, click Update all labels to copy the      

              «AddressBlock» merge field to the other cells. 

13     At the bottom of the Mail Merge pane, click Next: Preview your labels to display the 

            data source content in place of the merge fields. 
 

Figure 106 Word creates a 30-cell table that meets the label 
specifications. 

Figure 107 The merge fields in the first cell of the table will be used as a 
template for all the other cells. 
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Figure 108 The six labels, as they will appear after the merge. 

 

Now we’ll merge the data source and main document into a new document that   

contains the labels. 

 

14     At the bottom of the Mail Merge pane, click Next: Complete the merge. Then 

in the 
Merge area of the Mail Merge pane, click Print. 

 

15     With the All option selected in the Merge to 

Printer dialog box, click OK. 

16 In the Print dialog box, verify that the name of 

the printer you want to use to print the labels 
appears in the Name box, and then click OK to 

print the labels. The labels are printed on regular 
paper on the printer you selected. If you want to 
print on label sheets, insert the sheets in the 
printer’s paper tray or manual feed location 
before clicking 

Figure 109 You have the opportunity 
to exclude  records from the merge 
before printing the labels. 
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CHAPTER-9 

Page setup and Print Document 
9.1 Changing a document’s background 

Whether you’re creating a document that will be printed, viewed on a computer, or pub- 

lished on the Internet and viewed in a web browser, you can make your document stand out by 

adding a background color, texture, picture, or border to the document pages. 

When it comes to backgrounds, the trick is to not overdo it. The effects should be 

subtle enough that they do not interfere with the text or other elements on the page or make 

the document difficult to read. 

1 On the View tab, in the Zoom group, click the One Page button to display the whole page 

in the program window. 

2 On the Design tab, in the Page Background group, click the Page Color button. On the Page 

Color menu, in the Theme Colors palette, click the second swatch under the main green swatch 

(Green, Accent 6, Lighter 60%) to change the document background to the selected color. 

3     On the Page Color menu, click Fill Effects to open the Fill Effects dialog box. 

4     In the Colors area, select the Two 

colors option. Leave Color 1 set to 

green. Click 

the Color 2 arrow, and in the Theme 

Colors palette, click the third swatch 

under the 
main orange swatch (Orange, Accent 2, 

Lighter 40%). The Variants and Sample 
areas change to show various 

combinations of the two colors. 

5 In the Shading styles area, click 

each option in turn and observe the 

effects in the Variants and Sample areas. 

Notice that some shading styles have 

only two variants. Then click Diagonal 

down. 

6 In the Variants area, click the 

lower-left option to preview its effect. 

Then click OK to change the document background to match the sample. 

Now let’s format the page background with a texture fill. 

7     Redisplay the Fill Effects dialog box. Click the Texture tab to display the 24 texture fill 

options that come with Word. 

Figure 110 You can configure fill effects with multiple colors 
and in a variety of directions. 
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8 Scroll through the gallery to 

familiarize yourself with the available 

textures. Click the first texture swatch in the 

second row (Water droplets), and then click 

OK to format the page background with the 

texture. Notice that the texture swatch has 

been configured to repeat seamlessly across 

the page. 

Next, let’s format the page background with 
a picture fill. 

9 Redisplay the Fill Effects 
dialog box. First click the Pattern tab to 
view the available pattern fill options. 
Then click the Picture tab, and click the 
Select Picture button to open the Insert 
Pictures dialog box. 
 
TIP You can insert background pictures from 

the Texture tab or from the Picture tab with 

slightly different results. Inserting an image 

from the Texture tab adds it to the Texture 

gallery. 

 
10 In the From a file area of the 
Insert Pictures dialog box, click Browse. In 
the Select Picture dialog box that opens, 
browse to the Chapter09 practice file 
folder and double-click the MarbleFloor 
image. Then in the Fill Effects dialog box, 

click OK to change the page 
background to display a blurred 
picture of the marble floor in the 
Doge’s Palace in Venice. 
 
TIP Word fills the page with as much of the picture as will fit. If 

one copy of the pic- ture does not completely fill the page, 

Word inserts another copy, effectively “tiling” the image. If the 

picture is particularly large, only a portion of it will be visible. 

 
Finally, let’s add a border to the page. 

Figure 111 The page with the Water Droplets texture applied to 
the background. 

Figure 112 You can select a background picture from your computer, network 
location, or an online source. 

Figure 113 The page with the MarbleFloor 



11     In the Page Background group, click the Page Borders button to display the Page 
Border page of the Borders and Shading dialog box. 

 
12 In the Setting area of the Borders and Shading dialog box, click Box. Then click the 

Color arrow, and in the Theme Colors palette, click the fourth swatch under the 
main gold swatch, (Gold, 
Accent 4, Darker 25%). 

13 Scroll through the Style list, 
clicking any line style option 
you like to apply it to the 
page in the Preview pane. 
When you find a style you 
like, click OK. We chose a 
triple border near the bottom 
of the list. 

 
1
4 

 

On the Insert tab, in the Pages group, click Page Break, and then scroll to display the 

new second page. Notice that the background options are applied to all pages of the 
 KEYBOARD SHORTCUT Press Ctrl+Enter to insert a page break. 

 
9.2 Adding watermarks 

A watermark is a faint text or 
graphic image that appears on the page 
behind the main content of a document. 
A common use of a text watermark is to 
indicate a status such as DRAFT or 
CONFIDENTIAL. When you want to 
dress up the pages of your document 
without distracting attention from the 
main text, you might consider displaying 
a graphic water- mark, such as a 
company logo or an image that subtly 
reinforces your message. Watermarks 
are visible in printed and online 
documents, but because they are faint, 

they don’t interfere with 

Figure 114 The Page Border page is identical to the Borders 
page from which you format paragraph borders, except that 
an Art option is available for page borders. 

Figure 115 The blank page with a border applied on top of the 
background picture. 



the readers’ ability to view a document’s main text. 
 
1 On the Design tab, in the Page Background group, click the Watermark button to 
display the Watermark menu. 
 
 

2 Scroll through the watermark 
galleries, noticing the available options. 
Clicking any of these options inserts the 
specified watermark in light gray on 
every page of the current document. 

3     At the bottom of the menu, click 
Custom Watermark to open the Printed 
Watermark dialog box. Then click Text 
watermark. 

4     Click the Text arrow, and then in 

the list, click DRAFT. 

5     Click the Color arrow, and then in 
the Theme Colors palette, click the 
main purple 

swatch (Purple, Accent 4).                                                                                                                            
9 

6     With the Semitransparent check 
box and Diagonal layout option 
selected, click OK 

to insert the watermark diagonally 

across the page and close the dialog 
box. 

 
TIP Watermarks are so named because the process of creating one on an actual sheet of paper 
is done by using water. A well-created watermark appears to be more part of the paper than of 

the content. 

 
 

Figure 116 You can use a predefined watermark or click 
Custom Watermark to define your own. 



 
Figure 118 The text watermark is faint 
enough that the document text is 
still legible, but bold enough to be 
 

 

Next let’s insert a picture watermark. 

7     Redisplay the Printed Watermark dialog box. Click Picture watermark, and then click 
Select Picture to open the Insert Pictures dialog box. 

8 In the From a file area of the Insert Pictures dialog box, click Browse. In the Insert 
Picture dialog box that opens,  

9 In the Printed Watermark dialog box, click the Scale arrow and then, in the list, click 
200%. 

10 With the Washout check box selected, click Apply to insert the watermark in the 
document but leave the dialog box open. Drag the dialog box by its title bar 
until the watermark is displayed. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 117 In this dialog box, you can specify a 

custom picture or text watermark. 

Figure 119 You can adjust the size of a picture watermark, but you can’t change its angle. 



Let’s make the watermark larger. 
 

11 In the Printed Watermark dialog box, click in the Scale box, drag to select 200%, and 
enter 400% to replace the existing setting. Then click OK to change the watermark 
size and close the dialog box. 
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9.3 Previewing and adjusting page layout 

Working on your document in the default Print Layout view means that you 
always know how the document content will appear on the printed page. While you’re 
working in the document, you can use the commands in the Page Setup group on the 
Page Layout tab to adjust the margins and the direction of the page (the page 

orientation) to best suit your con- tent and delivery method. If you’re planning to deliver 
the document at a page size other than the default, you can format the document to 
display and print correctly by changing 
the paper size. 

 
Although the layout of each page is visible in Print Layout view, it’s also a 

good idea to pre- view the whole document before you print it. This gives you more of 
a high-level overview of the document than when you’re working directly in the 
content. Previewing is essential for multipage documents but is helpful even for one-
page documents. You can preview a document by displaying the Print page of the 
Backstage view and then page through the document displayed in the right pane. 
This view shows exactly how each page of the docu- ment will look when printed on 
the specified printer. 

 

Figure 120 The picture watermark adds visual interest without obscuring 
the text. 



 

 
 

If you don’t like what appears in 
the preview pane of the Print 
page, you don’t have to leave the 
Backstage view to make 
adjustments. The left pane of the 
Print page provides access to 
many of the commands that are 
available in the Page Setup group 
on the Page Layout tab, allowing 
you to change the following 
document settings while 
previewing their effect on 
the printed page: 

 
▪ Orientation You can switch 

the direction in which a page is 
laid out on the paper. 

The default orientation is 
Portrait, in which the page 
is taller than it is wide. You 
can 
set the orientation to Landscape, in which the page is wider than it is tall. 

▪ Paper size You can switch to one of the sizes available for the selected printer by 
making a selection from a list. 

▪ Margins Changing the margins of a document changes where information can appear 

on each page. You can select one of Word’s predefined sets of top, bottom, left, and 
right margins, or set custom margins. 

 
TIP All the pages of a document have the same orientation and margins unless you 

divide the document into sections. Then each section can have independent orienta- tion 

and margin settings.  
 

To configure multiple print layout settings in one place, or to configure settings for only 
specific sections of the document, click Page Setup on the Print page (or click the Page 
Setup dialog box launcher on the Page Layout tab) to open the Page Setup dialog box, in 
which you can configure additional options. 

 
When you have the settings as you want them, click the large Print button at the top of the 
Print page to send the document to the printer. 
 

9.4 Inserting Header and Footer 
Header and footer You can display information on every page of a document in re- 

gions at the top and bottom of a page by selecting a style from the Header or Footer gallery. 
Word displays dotted borders to indicate the header and footer areas, and displays a Design 
tool tab on the ribbon. You can enter and format information in the header and footer by 
using the same techniques you do in the document body and also by using commands on 

Figure 121 The Print page of the Backstage view. 



the Design tool tab. You can have a different header and footer on the first page of a 
document and different headers and footers on odd and even pages. 

We can add headers and footers to the document. We’ll use two different headers 
designed for odd pages and even pages, and their coordinating footers, so that when the 
document is printed double-sided, the headers and footers will always appear on the 
outside edges of the paper 

1. Scroll to the second page. Select and delete the heading Simple Room Design, because 
its function is now fulfilled by the document title on the cover page. 
2. With the cursor at the beginning of page 2, on the Insert tab, in the Header & Footer 
group, click the Header button. Scroll through the Header gallery, and then click the Facet 
(Even Page) header to add it to the page. Notice that although you’re on the second page of 
the file, the header displays page number 1. This is because the cover page is counted 
separately from the document pages. 

 
TIP You can mix different headers, footers, and document themes to create a docu- ment 
that has the look and feel you want. 

 
3. Investigate the configuration options available on the Design tool tab. In the Options 

group, select the Different Odd & Even Pages check box, and notice that the header 
label changes from Header to Odd Page Header. 

 

 

Figure 122 The header label helps you determine which kind of header to use. 

TIP In step 3, we inserted an even page header on the second page of the docu- ment, 

but Word now indicates that it is an odd page, because it is page number 1 of the 

document following the cover page. However, if we print the document double- sided, 

the even page header will align appropriately on the outside edge of the paper when we 

turn the pages. 

 

14 In the Navigation group, click the Next button to move to the header area at the 
top of the page 3. In the Header gallery, click the Facet (Odd Page) thumbnail to 
insert the header. Again, the seemingly incorrect page number 2 appears in the 
header because the document content is numbered separately from the cover 
page. 

 
TIP To use a numbering scheme other than arabic numerals, to number pages 

by chapter, or to control the starting number, click the Page Number button in 

the Header & Footer group, and then click Format Page Numbers. In the Page 

Number Format dialog box, you can select from several page numbering 

formats and options. 



 
15 In the Navigation group, click the Go to Footer button to move the cursor to the 

footer area at the bottom of the last page of the document. In the Header & 
Footer group, click the Footer button, and then in the gallery, click the Facet (Odd 
Page) thumbnail to insert the footer and the associated document properties. 

 
16 In the Navigation group, click the 
Previous button to move to the footer area 
of the second page. In the Footer gallery, 
click the Facet (Even Page) thumbnail to 

insert the footer and the associated 

document properties. Then in the Close 
group, click the Close Header and Footer 
button. 
All pages of the document other than the 
cover page now have a header and footer. 
Next, let’s add a quote box to emphasize a 
specific phrase in the document. 

17 On the Insert tab, in the Text 
group, click the Quick Parts button, 
and then click Building Blocks 
Organizer to open the Building 
Blocks Organizer dialog box shown 
at the beginning of this topic. 

18     Scroll through the Building blocks list, 
previewing a few of the building blocks. 

Click the Name column heading, 

double-click the separator to the 

right of the 
Name column heading so that all 

the names are visible, and then 

scroll through the 
list again. Notice that page 
elements of the same theme are coordinated. 

19 In the Building blocks list, click Semaphore Quote, and notice its position on the page 
shown in the preview pane. Then click Insert to insert the quote box in the same 
position on the document page and display the Drawing Tools Format tool tab, from 
which you can format the quote box contents. 

 
20 Change the zoom level of the document to 100% so that the text is legible. Select and 

copy the last sentence of the fourth paragraph of the document (Go with what you 
love…). Then click the placeholder in the quote box to select the placeholder text. 

 

Figure 123 Figure 123 Headers and footers can include any 
information you want to display, including graphics. 



 

Figure 124 Placeholder text in the quote box tells how to enter text and move the quote box on the page. 

21. On the Insert tab, in the Header & Footer group, click the Header button, and then click 
Edit Header. 

Notice that on the Header & Footer Tools Design tab, in the Navigation group, the Link to 

Previous button is selected. This indicates that this section has inherited the header 

and footer settings of the preceding section. Because the preceding section has no 

header or footer on its first page, this one doesn’t either. 
 
 

22 On the Design tool tab, in the Options group, clear the Different First Page check box to 
add the header to this page.         

 
You might have to adjust the header and footer settings after creating a new 
section. 

 
23     Click the Close Header and Footer button. 

 

9.5 Printing Document 
1 Display the Print page of the Backstage view. Notice that this is a two-page 

document. The colored document background is not displayed in the preview 
pane, because it will not be printed. 

2     In the Printer area, click the active printer to display the list of installed printers. 
 3 In the Printer list, click the printer to which you want to send the document. 

Notice that the options available on the Print page might change when you select a 
differ- ent printer. 

 



                                                                
TIP You can manage these 

programs and printers from the 

Devices And Printers control 

panel item. 
 

4 Point to the Information icon in 
the upper-right corner of the 
Printer area, or to the selected 
printer name, to display a 
ScreenTip that contains printer 
status information. 

Figure 126 Programs to which you can print, such as 
Microsoft OneNote, might be installed here as well as local 
and network printers. 

Figure 125 The printer status information includes the installed driver and 
connection information. 
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5     In the Settings area, click Print All Pages, and then scroll through the list to review 
the options for printing specific parts of the document, or document information. 

 

 
Figure 127 You can choose to print all or part of a document, or to print information that is selected 

 
6     In the list, click Custom Print, and then in the Pages box, enter 2. 
7 In the Copies box at the top of the page, enter 2. Then click the Print button to print two 

copies of the second page of the document on the selected printer and return to the 
document. 
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Frequently used shortcuts 

This table shows the most frequently used shortcuts in Microsoft Word. 

To do this Press 

Open CTRL+O 

Save CTRL+S 

Close CTRL+W 

Cut CTRL+X 

Copy CTRL+C 

Paste CTRL+V 

Select all CTRL+A 

Bold CTRL+B 

Italic CTRL+I 

Underline CTRL+U 

Decrease font size 1 point CTRL+[ 

Increase font size 1 point CTRL+] 

Center text CTRL+E 

Left align text CTRL+L 

Right align text CTRL+R 

Cancel Esc 

Undo CTRL+Z 

Re-do CTRL+Y 

Zoom ALT+W, Q, then tab in Zoom dialog box to the value you want. 
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